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1. About

1.1. Purpose of the document

This document contains detailed information about UAS data processing in the PHO-
TOMOD UAS program. The document contains recommendations of processing order,
program properties to obtain the best results, and also contains description of additional
possibilities when working with UAS data.

1.2. Brief description of system features

The PHOTOMOD UAS program is purposed to process data from unmanned aircraft
system (UAS). There is a limit on using of the source data when working with program.

Only central projection images with size not more than 100 Mpix could be used a source data.

The following definitions for UAS projects processing are provided in the program:

• preliminary preparing of source images;

• images interior orientation;

• relative orientation of images;

• input and measurement of GCP coordinates;

• Images exterior orientation;

• vectorization;

• stereovectorization;

• building DEM;

• creating orthomosaic;

• creating digital map;

• creating 3d-models.

1.3. Technical Support

The Racurs company technical support provides the actual information about system
functionality, characteristics, price and services.

For technical support use one of the following ways:
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• e-mail: support@racurs.ru;

• phone: +7 (495) 720-51-27;

• mail: RACURS Co., Ul. Yaroslavskaya, 13-A, office 15, Moscow, Russia.

1.4. Distribution kit

The PHOTOMOD UAS program is a stand-alone software, which does not require the
PHOTOMOD system installation. Also the program could be launched as a module of
the PHOTOMOD system.

The hardware and software PHOTOMOD system requirements are given in detail in
“System requirements” in the “General information” User Manual in the main PHOTO-
MOD documentation set.

License software distribute in a branded box.

The company name is place on the front. On the reverse side are placed address,
technical support service phone and e-mail, web-site of company.

The system distribution kit includes:

• CD-ROM containing the system setup files and the documentation files in PDF format;

• ’System installation and configuration Manual;

• Unique hardware lock key (see “Protection of the system” chapter of “General inform-
ation” User Manual).

2. System installation
Prior to the system installation it is desirable to insert Sentinel HL security key into the
USB-socket of the workstation.

The system requires 2 GB of free hard disk space.

To start the system installation, launch the setup.exe file or input the installation software
and launch the autorun.exe file.

The PHOTOMOD window opens.
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Fig. 1. PHOTOMOD installation window

Click Install › PHOTOMODUAS. The Installation PHOTOMOD 8 UASwindow opens.

The system initial installation process consists of a sequence of steps with instructions.

In case of cancel at any step, installed program files and data are not removed. To complete
the system installation, restart the autorun.exe or setup.exe file and go through all steps again.

2.1. Preparation step
It is strongly not recommended to install the system in folder with name, which contains letters,
different from Latin. By default for the C:\Program Files\PHOTOMOD_8_UAS_x64 folder is
used.

6

Processing of UAS data (Windows x64)PHOTOMOD 8.1



1. Choose the installer language. Click OK;

2. Read the welcome and warning messages. Click the Next button.

3. Read the license agreement. If you agree with it, set the I accept the terms in the
License Agreement checkbox on and click the Next button.
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4. Define the folder to install the program files of the system. Click the Next button.

5. Enter a folder name for the PHOTOMOD programs and modules in the Windows
Start menu. A shortcuts in the Windows Start menu will be created by default.
Otherwise – clear the appropriate checkbox. Click the Install button.
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2.2. File copy stage

1. Wait until the installation is complete;

2. When installation complete perform one of the following actions:
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• [optional] clear the Start PHOTOMOD 8 UAS x64 checkbox and click the Finish
button to complete the installation process without program launch;

• [optional] leave the Start PHOTOMOD 8 UAS x64 checkbox set and click the
Finish button to proceed to the system configuration stage.

The Create shortcuts on Windows desktop checkbox is set on by default. Clear it if
needed.

If the Start PHOTOMOD 8 UAS x64 checkbox is set, the PHOTOMOD UAS program
will launch automatically.

If the security key or security key drivers (they must be installed automatically during
the program installation) were not found, the error message displays.

Make sure that the Sentinel HL security key is inserted into the USB-socket of the
workstation. Install the security key drivers manually and restart the system.

In case of problems contact the Racurs company technical support service (see Sec-
tion 1.3).
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2.3. System configuration stage

During the first launch of the system, the message about the required detailed configur-
ation appears. The initial setup of the program can be performed in various ways, de-
pending on the circumstances of the system installation on a particular workstation.
The most common situations are the following:

• The system was installed on this workstation for the first time. The user needs to
create a folder for storing settings, a resource system, and profiles for organizing
local and/or network work. This procedure will be discussed in detail below in this
chapter.

• If otherRacurs software products (PHOTOMOD, PHOTOMODConveyor) are already
installed and configured on the workstation, the user can quickly connect the installed
program to existing profiles and resource systems.

If the connection did not occur automatically during the first launch of the installed
program, then in the Initial setupwindow that opens (see below), an already existing
settings folder used by previously installed software products is indicated;

• The system is installed and configured on several workstations connected to each
other via a local network. A new computer is added to the local network where this
program was installed for the first time. Connecting such a workstation to an existing
network profile is described in “Connecting to existing network profiles” chapter of
“General information” User Manual.

2.3.1. Fast system configuration

During the first launch of the system the PHOTOMOD UAS initial (fast) setup windows
are opened.

If other Racurs software products (PHOTOMOD, PHOTOMOD Conveyor) are already installed
and configured on the workstation, the user can quickly connect the installed program to existing
profiles and resource systems. To do this choose the already existing settings folder used by
previously installed software products in PHOTOMOD initial setup window.

To minimize the process of the program quick setup and go to the PHOTOMOD initial setup
window (as part of the standard setup of the program), close the quick setup window (or click
Cancel).

1. Click the button to select a physical folder on a local PC to store resources of
the PHOTOMOD UAS projects (see the “Main definitions of resources system”
chapter of the “General information” User Manual). Click OK.

It’s impossible to use logical disk root folder.

Resources can take up a significant amount of free space on hard drive.
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Fig. 2. Choosing a folder to store the projects (an intermediate data)

2. In the Settings folder field is displayed path to the PHOTOMODUAS8.VAR folder,
that is used to store configuration files. Click the button to change path to
configuration folder or click OK to finish fast system configuration and create the
local profile automatically (see the “Creating local profile” chapter of the “General
information” User Manual).

Fig. 3. Choosing a folder to store the configuration files

The Control Panel module is used to configure detailed system settings during the further
work. More details about program resources, recommendations on organizing of local or
network work, and about creating profiles and virtual folders connecting see the “Control
Panel. Profiles management” chapter of the “General information” User Manual.

2.3.2. Advanced system configuration

If the existing folder for data storage (or configuration files folder) are not specified
during the fast system setup, the message about the required detailed configuration
appears. To do this, perform the following:

1. Click OK.

Fig. 4. Information message
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2. The PHOTOMOD initial setup window opens:

Fig. 5. The PHOTOMOD initial setup window

In the Settings folder section is displayed path to the PHOTOMODUAS8.VAR
folder, that is used to store configuration and temp files. Click the button to
change path to configuration folder.

If other Racurs software products (PHOTOMOD, PHOTOMOD Conveyor) are already in-
stalled and configured on the workstation, the system provides for connecting the program
to existing profiles and resource systems.

For this, the settings folder is to be specified which is used by these software products.
In this case, the user will not be required to perform the steps described below to create a
new local profile.

Choose For all users on this computer to use one configuration folder for all users of
current workstation, otherwise choose Only for me.

In theCentralizedmanagement folder section set theUse checkbox on and define
a folder.

Creation of a local profile is described in this Chapter. Network profiles management is
described in “Creating network profile” chapter of the “General information” User Manual.

3. An info that at least one local profile must be created appears:
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Fig. 6. Information message

Нажмите ОК.

4. Specify a local profile name:

Fig. 7. Local profile name setup

Click ОК.

5. Input a virtual folder name – arbitrary text is used to identify data in folder.

Fig. 8. Connect virtual folder
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In the Folder section choose a physical space for connecting as a virtual folder:

• choose Folder to use only one network or local physical folder click the
button and choose a folder;

It’s impossible to use logical disk root folder.

To connect folder only read access for this folder is required.

Local profile folder could be placed both on a workstation, where the system runs, and
on any workstation of the network.

• [optional] choose Storage group to use several local or network folders as virtual.

The use of a group of storages is described in detail in “Storages” chapter of the “Gen-
eral information” User Manual.

Click ОК.

2.4. System deinstallation

To remove the system from computer, close all modules of the system and choose
Start › Programs › PHOTOMOD 8 UAS x64 › Uninstall PHOTOMOD UAS x64 or use
standard tools in Control panel of Windows operation system.

15

Processing of UAS data (Windows x64)PHOTOMOD 8.1

general.pdf
general.pdf


3. Interface and its elements

3.1. Work area interface

Fig. 9. The main program’s window

The GUI contains the following elements:

• title with name of opened project (A);

• the main menu bar (B);

• the Aerial Triangulation, Compute DEM and Compute Orthophoto tabs (P). The
tabs layout and content displays the main steps of UAS data processing workflow;

• the main toolbar is used for quick access to main program functions (C);

• the optional toolbars is used for quick miscellaneous program functions access (O);

The system interface is flexible for customizing the locations of additional toolbars according
to the user’s needs. Additional toolbars can either be fixed in designated sections of the work
area (top or bottom, right or left) or undocked by the user and placed in any place in the 2D
window.

Depending on the user-set interface configuration, docked additional toolbars can be partly
minimized (some buttons will be hidden). Docked (optionally minimized) subtoolbars are
displayed as one line, vertical or horizontal, depending on their location.
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By default, additional toolbars are docked at the top of the workspace, to the right of the main
toolbar. Additional toolbars are marked with a special icon located on the left or top (de-
pending on the location) edge of the panel. To maximize the toolbar, click ( ) on the right
(at the bottom).

Undocked additional toolbars are always displayed horizontally, in one line, in a fully maximized
form. To undock a toolbar (or pinpoint it in any place), move the cursor over the icon and,
holding down the left mouse button, drag the toolbar to the area of its targeted location (the
cursor’s shape changes ( ) when it is possible to capture the toolbar).

• the 2D-window, used for data displaying, contains the following elements:

○ the toolbar is used for the 2D-window modes managing (D);

○ the work area is used for viewing and processing with loaded data of project (N);

○ the navigation bar is used for fast moving on the specified block images area of
project (E);

To do this, click on the chosen point in Navigation bar. To set the layers visibility, move
to the Navi tab in the layer manager.

○ the Layer manager is used for managing of project layers (F);

○ the work area is used to display the axes direction of project coordinate system
(M);

○ the status bar is used for viewing current real (ground) and pixel marker coordinates
and brightness, contrast and gamma data adjustment in the work area (K, L);

GSD value is displayed to the right of the current marker coordinates (excluding radiometric
correction windows).

RGB brightness values are displayed to the right of the current marker coordinates. When
placing the marker within the work area, the following brightness values are displayed:
R=128 G=128 B=128.

○ the work area is used for viewing project coordinate system (G);

Double-click on coordinate system to change it in case of work without project mode. The
Project properties window is used for that, in other cases.

If the is “Lat/Lon” coordinate system type is used (available in work without project mode
only), in the status bar is displayed lat/lon in grade by XY and altitude in meters.

○ scroll bar in 2D-window (H);
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○ the Status bar, near the current marker coordinates (K), displaying messages of
error or success (e.g., after marker was not successfully placed to ground with
correlator – Bad point: correlation error).

3.2. The main toolbar

The main toolbar is used for quick access to main program functions and also contains
Aerial Triangulation,Compute DEM andComputeOrthophoto tabs. The tabs names,
layout and content displays the main steps of UAS data processing workflow;

Table 1. Brief description of main toolbar

FunctionButtons
to open block editor window (see the “Project creation” User Manual)
to reload project to display the last saved version of project
to perform import of exterior orientation from metadata
to open block layout window (see the “Aerial triangulation” User Manual)
to open block editor window (see the “Project creation” User Manual)
to display all images, loaded to project, in the Block scheme window
to display only selected on scheme images in the Block scheme window
to load triangulation points
to open 2D-window for selected stereopair (see the “Vectorization” User Manual)
to launch the DustCorrect module to edit MS-TIFF images (see the “Project creation”
User Manual)
to run the GIS Panorama Mini (this software is not included with the PHOTOMOD but
can be installed separately)
to launch the 3D-mod module
to create, open and save regular nodes grid (see the “Create DTM” User Manual)
to load vector file into the project (see the “Vectorization” User Manual)
to load DEM file
to load georeferenced raster image to project as a layer
to load web-map
to undo the last action (see the “General system’s parameters” User Manual)
to display the list of last actions (see the “General information about system” User
Manual)
to redo the last undone action (see the “General system’s parameters” User Manual)
to open the Marker window (see the menu description in “Vectorization” User Manual)
to open the Measurements window (see the menu description in “Vectorization” User
Manual)
to arrange 2D-windows evenly
to stack 2D-windows
to refresh all opened 2D-windows
to close all 2D-windows
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FunctionButtons
to open the general program parameters window (see the “General system’s parameters”
User Manual)

If the GIS Panorama executable file is not found, an appropriate system message will
appear. The software description and URL hyperlink (for download) are indicated in
this message. Click Yes to go to path settings (see the “Paths settings” chapter of the
“General system’s parameters” User Manual.

3.2.1. The main toolbar tabs

Table 2. Brief description of the Triangulation tab of the main toolbar

FunctionButtons
is used for adding image files, locating in the re-
sources out of active profile, to the selected strip

From files

(see the “Adding images from files” chapter of the
“Creating project” User Manual)
is used for adding image files, locating in the re-
sources of active profile, to the selected strip (see

From resources

the “Adding images from resources” chapter of the
“Creating project” User Manual)
to perform import of exterior orientation and interior
orientation parameters from metadata (see the

Import from metadata

“Import orientation from metadata” chapter of the
“Aerial triangulation” User Manual)
to input/edit parameters of project cameras, and
also to assign cameras to project images (see the

Manage cameras

“Images interior orientation” chapter of the “Aerial
triangulation” User Manual)
to perform import of exterior orientation data from
file of text format (see the “Import of exterior orient-

Import from file

ation parameters” chapter of the “Aerial triangula-
tion” User Manual)
to open exterior orientation data list (see the “List
of exterior orientation parameters” chapter of the
“Aerial triangulation” User Manual)

Exterior orientation data list
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FunctionButtons
to setup and start аutomatic tie points measurement
using UAS data (see the “Automatic measurement

Automeasure tie points

of tie points coordinates (aerial survey)” chapter of
“Aerial triangulation” User Manual)
to open tie points list (see the “The “Triangulation
points” window” chapter of the “Aerial triangulation”
User Manual)

Tie points list

to perform import of ground control points from *.txt
and *.csv files (see the “Import of GCP catalogue”
chapter of “Aerial triangulation” User Manual)

Import catalog

to open GCP list (see the “GCP list” chapter of the
“Aerial triangulation” User Manual)

GCP list

to open the adjustment toolbar (see the “Block ad-
justment” User Manual)

Block adjustment

to perform adjustment using imported exterior orient-
ation parameters (see the “Aerial triangulation” and
“Block adjustment” User Manuals)

Direct georeferencing

Table 3. Brief description of the Compute DEM tab of the main toolbar

FunctionButtons
to start automatic points calculation (see the “Points
automatic calculating” chapter of “DTMGeneration”
User Manual)

Compute points

to launch the buildings and vegetation filter for points
(see the “Buildings and vegetation filter” chapter of
“DTM Generation” User Manual)

Buildings and vegetation filter

to build TIN by points and breaklines (Ctrl+N, T,
see the “Building TIN” chapter of “DTMGeneration”
User Manual)

Build TIN

to build DEM by loaded TIN (Ctrl+N, D, see the
“DEM creation by TIN” chapter of “DTMGeneration”
User Manual)

Build from TIN

to create contour lines by DEM (see the “” chapter
of “DTM Generation” User Manual)

Build contours

to build dense DEM using SGM method (see the
“Dense DEM generation using SGM method”
chapter of “DTM Generation” User Manual)

Dense model

to launch the buildings and vegetation filter for DEM
(see the “Slope based filter” chapter of “DTM Gen-
eration” User Manual)

Slope based filter

to restore null cells of DEM using the smooth inter-
polation method (see the “Filling null cells using

Fill NULL cells

smooth interpolation” chapter of “DTM Generation”
User Manual)
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Table 4. Brief description of the Compute Orthophoto tab of the main toolbar

FunctionButtons
to display the orthorectification toolbar (Ctrl+Alt+M)
(see the Orthomosaic building User Manual)

Orthorectification

to start PHOTOMOD GeoMosaic program (see the
The Orthophotomaps creation User Manual)

Start GeoMosaic

3.3. Brief description of main menu

The program main menu contains the menu items for mosaic creation, vector data
processing, additional applications starting and setting parameters.

Table 5. Main menu

FunctionMenu
contains menu items to create, open, save and
convert project, and also to get an information about
project

Project

to form images block of mosaic projectBlock
contains menu items to interior orientation, load and
use ground control and triangulation points, exterior

Orientation

orientation parameters and also to import and export
triangulation points for various formats
to create, open and save regular nodes grid (see
the “Regular grid of nodes” chapter of the “Create
DTM” User Manual)

Grid

to prepare the base layers for the further DTM/DSM
creation: calculating 3D-points, building TIN & tex-

Terrain

tured TIN 3D surface, building DEM, building LAS
point clouds, building true ortho, building smooth
contours
purposed for creating, editing, import/export of vec-
tor data (see the “Vectorization” User Manual)

Vectors

to load and georeference raster images, and also
to launch additional modules for editing and orthorec-
tification images

Rasters

to launch applications, load additional data, set
general parameters and edit coordinate systems

Service

to open additional toolbars and windows: new 2D-
window, Marker and Measurements windows, win-

Window

dow of Object Attributes (see “The “Windows” menu”
chapter of the “General information about system”
User Manual)
to start the “Help” systemHelp
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3.4. The “Project” menu
Table 6. Brief description of Project menu

FunctionMenu items
to create a new project (see the “Project creation”
chapter of the “Creating project” User Manual)

New...

to open the project management window (see the
“Project management window” chapter of the “Cre-
ating project” User Manual)

Open/Manage (Ctrl+Alt+O);

to create a copy of project selected in the list (see
the “Copying project” chapter of the “Creating pro-
ject” User Manual)

Copy

to create project backup (see the “Creating project
backup” chapter of the “Creating project” User
Manual)

Backup project...

exports project data into a *.xml file, which is used
inBlocks Exchange XML protocol betweenPHOTO-

Project export...

MOD and external software such as Agisoft
Metashape or Bentley ContextCapture (only for
central projection projects, see the “Export and Im-
port of Projects” chapter of the “Creating project”
User Manual)
imports project data from a *.xml file, which is used
inBlocks Exchange XML protocol betweenPHOTO-

Project import...

MOD and external software such as Agisoft
Metashape or Bentley ContextCapture (only for
central projection projects, see the “Export and Im-
port of Projects” chapter of the “Creating project”
User Manual)
to reloads a project to update it after changes ap-
peared during mutual work

Reload

to re-calculate a project data after editing of some
parameters, e.g. re-calculates interior orientation
after changing camera parameters

Synchronize

to close current project and to start “without project”
mode (see the “$QUOTE$"Without project” mode”
chapter of the “Creating project” User Manual)

Close

to open the window used to view and edit some
parameters of opened project (see the “Project

Properties

properties” chapter of the “Creating project” User
Manual)
to open a list of projects opened recently in the
system

Recent

to merge data from several projects of active profile
(see the “Joining projects” chapter of the “Creating
project” User Manual)

Join projects...

22

Processing of UAS data (Windows x64)PHOTOMOD 8.1

project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf
project.pdf


FunctionMenu items
to display processing status of the following project
stages (see the “Viewing project report” chapter of
the “Creating project” User Manual)

Project state

3.5. The “Block” menu

The Block menu, buttons of Block editor window’s toolbar and Block forming addi-
tional toolbar are used to work with images block in 2D-window. It includes extended
features for images block forming, as well as additional functions for block scheme
creation and obtaining of auxiliary data.

Some menu items allow to manage operations with selected images in 2D-window.
The Tools additional toolbar is used for group selection (highlighting) of images block
in 2D-window (see the “Vectorization” User Manual).

Detailed information aboutBlockmenu items, buttons ofBlock editorwindow’s toolbar
and Block forming additional toolbar see in the “Project creation” User Manual.

Table 7. Brief description of the Block menu

FunctionMenu items
to add image files, locating in the resources out of
active profile, to the selected strip (see the “Adding

Add images from files

images from files” chapter in “Creating project” User
Manual)
to add image files, locating in the resources of active
profile, to the selected strip (see the “Adding images

Add images from resources

from resources” chapter in “Creating project” User
Manual)
to automatically add images from specified folder
of active profile resources to selected strip, with or
without its subfolders

Add images from resource folder

contains menu items used to split images block to
strips automatically using images names or exterior

Split to strips

orientation parameters (see the “Splitting into strips”
chapter in “Creating project” User Manual)
to open the Block editor windowBlock editor (Ctrl+Alt+B)
to open the Block layout window to build block
scheme in 2D-window considering source or ac-

Block layout (Ctrl+Alt+L)

quired data (see the “Aerial triangulation” User
Manual)
to create map of images and/or strips overlap in
new vector layer (see the “Creating overlap map”
chapter of the “Creating project” User Manual)

Create overlap map...

contains the Additional menu (see below)Additional
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Table 8. Brief description of the Block menu (Additional)

FunctionMenu items
to add new stripAdd strip
to delete selected strips of block in 2D-windowDelete strip
to view and edit properties of selected strips – strip’s
name and type (regular or irregular)

Strip properties

to invert strips orderInvert image order in strip
to move selected strips to the beginningSelected strips to block start
to move selected strips to the endSelected strips to block end
to add new stripAdd strip
to delete selected strips of block in 2D-windowDelete strip
to view and edit properties of selected strips – strip’s
name and type (regular or irregular)

Strip properties

to move selected strips one strip upMove selected strips up
to move selected strips one strip downMove selected strips down
to change regular strip to irregularMake selected strips irregular
to change irregular strip to regularMake selected strips regular
to remove selected images from projectDelete images
to select images in accordance with specified criteria
for deleting (see the “Deleting images selectively”
chapter of the “Creating project” User Manual)

Delete images selectively...

to display and edit properties of selected imageImage properties
opens a group of menu items used to images block
editing; allows to invert images order in a strip, and
to move selected image left/right/up/down

Move images

to perform radiometric correction of selected image
(see the “Radiometric correction” chapter in the
“Project creation” User Manual)

Image radiometric correction

to show images of block in 2D-window if the limita-
tion on images display is specified on the Block

Show images

scheme | Raster tab in the Settings window (see
“General information” User Manual)
to turn on/of selected images displayShow selected images only
to perform search for 16-bit project images without
radiometric correction (no *.rmc file associated with

Check images

the image, see “Radiometric correction” in the
“General information” User Manual). If images are
found in the project that meet the criteria described
above, an appropriate info message is issued
to exclude project images validation - check their
presence and compliance to images files during
project opening at the next working session

Mark all images as checked

to move marker to center of the image, selected in
the list of the Block editor window

Marker to selected image
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FunctionMenu items
to build brightness adjustment for all block scheme
(see the “Brightness adjustment” chapter in the
“Project creation” User Manual)

Brightness adjustment

to delete the brightness adjustment results (see the
“Brightness adjustment” chapter in the “Project cre-
ation” User Manual)

Delete brightness adjustment

to rotate selected images at any angle relatively to
initial or current position of block images

Rotate selected images

to rotate all or selected images of block considering
block layout data; images don’t rotate if the w\o

Rotate images by block layout

layoutwas used (see the “Aerial triangulation” User
Manual)
to define/calculate GSD value in meters for all or
selected images of block (see the “Specifying

Set GSD for selected images

ground sample distance (GSD)” chapter in the
“Project creation” User Manual)
to create vector layers with common block outline,
boundaries of all images or selected image of the

Create vector layer from block layout

block (see the “Creating vector layers from block
layout” chapter in the “Project creation” User
Manual)
to create pre-regions by images/stereopairs to
provide joint work on a project (see the “Creation

Build pre-regions

pre-regions for a block” chapter in the “Project cre-
ation” User Manual)
to export block scheme to KML formatExport block layout to KML...

3.6. The “Orientation” menu

To perform work on data collection for aerial triangulation serves theOrientationmenu,
and also buttons of the main toolbar and of the AT additional toolbar.

Table 9. Brief description of the Orientation menu

FunctionMenu items
to input/edit parameters of project cameras, and
also to assign cameras to project images (see the

Manage projects cameras (Ctrl+Alt+I)

“Project cameras management” chapter of the
“Aerial triangulation” User Manual)
to perform import of exterior orientation from
metadata (see the “Import orientation from

Import orientation from metadata...

metadata” chapter of the “Aerial triangulation” User
Manual)
to open the Exterior orientation data list (see the
“Import of exterior orientation parameters” chapter
of the “Aerial triangulation” User Manual)

Import exterior orientation

contains menu items used to measure tie points
coordinates in automatic mode (see the “Automatic

Automatic tie points measurements
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FunctionMenu items
measurement of tie points coordinates (general in-
formation)” chapter of the “Aerial triangulation” User
Manual)
to open catalogue of all tie points with their meas-
urements (see “The “Triangulation points” window”
chapter of the “Aerial triangulation” User Manual)

Tie points list (Ctrl+Alt+T)

to open catalogue of all ground control points, includ-
ing non-measured on block images (see the “GCP

GCP list (Ctrl+Alt+G)

list” chapter of the “Aerial triangulation” User
Manual)
to open the adjustment module, to view adjustment
results and errors correction (see the “Block adjust-
ment” User Manual)

Block adjustment (Ctrl+Alt+S)

to perform adjustment using imported exterior orient-
ation parameters

Direct georeferencing

to perform the subblock analysis by triangulation
points (see the “Subblock analysis” chapter of the
“Aerial triangulation” User Manual)

Subblock analysis

to create the processing report (see the “Processing
report” chapter of the “Aerial triangulation” User
Manual)

Processing report

to delete adjustment data (see the “Block adjust-
ment” User Manual)

Delete adjustment results

contains the Additional menu (see below)Additional

Table 10. Brief description of the Orientation menu (Additional)

FunctionMenu items
to open a report about interior orientation results
(see the “Report on interior orientation” chapter of
the “Aerial triangulation” User Manual)

Report on interior orientation

[only for film camera images] to measure manually
coordinates of fiducial marks on images (see the

Manual interior orientation

“Manual measurement of fiducial marks coordinates”
chapter of the “Aerial triangulation” User Manual)
[only for film camera images] to perform semiauto-
matic interior orientation, which is to use image-

Semiautomatic interior orientation

standard with template of fiducial marks position
used to search the same fiducial marks on other
project images (see the “Semi-automatic interior
orientation” chapter of the “Aerial triangulation” User
Manual)
[only for film camera images] to perform automatic
interior orientation, which is the automatic recogni-

Automatic interior orientation

tion of fiducial marks by their type, peculiar to certain
analog camera images (see the “Automatic interior
orientation” chapter of the “Aerial triangulation” User
Manual)
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FunctionMenu items
to re-calculate interior orientation parameters (see
the “Images interior orientation” chapter of the
“Aerial triangulation” User Manual)

Calculate interior orientation

to open the Select images window that is used to
delete results of fiducial marks measurements on

Delete interior orientation data

selected images (see the “Images interior orienta-
tion” chapter of the “Aerial triangulation” User
Manual)
contains menu items used to perform quick ties in
order to use the data for block layout creation (see

Quick Ties

the “Manual images linking (quick ties)” in “Aerial
triangulation” User Manual)
to open the Points measurement module used to
measure points coordinates in manual mode on

Open selected images for measurements

images selectedin 2D-window (see the “” chapter
of the “Aerial triangulation” User Manual)
to open the Points measurement module used to
measure points coordinates in manual mode on

Open images containing marker (Ctrl+Alt+K)

images, that contain marker position in 2D-window
(see the “The “Points measurement” module”
chapter of the “Aerial triangulation” User Manual)
to open the Points measurement module used to
measure points coordinates in manual mode on

Open in-strip stereopair

selected in-strip stereopair in 2D-window (see the
“The “Points measurement” module” chapter of the
“Aerial triangulation” User Manual)
to open the Points measurement module used to
measure points coordinates in manual mode on

Open inter-strip stereopair

selected in 2D-window inter-strip stereopair (see
the “The “Points measurement” module” chapter of
the “Aerial triangulation” User Manual)
to open the report with results of images relative
orientation in order to perform analysis and removal

Report on relative orientation (Ctrl+Alt+R)

of errors in tie points measurements (see the “The
“Points measurement” module” chapter of the “Aer-
ial triangulation” User Manual)
to choose types of triangulation points to be deleted
and delete them (see the “The “Triangulation points”

Delete point measurements

window” chapter of the “Aerial triangulation” User
Manual)
to remove the whole list of triangulation points (GCP,
check, tie) from triangulation points catalogue (see

Clear point catalogue

the “The “Triangulation points” window” chapter of
the “Aerial triangulation” User Manual)
to load measured coordinates of triangulation points
to 2D-window with possibility to setup of display of

Load triangulation points

certain type of points (see the “Triangulation points
display in 2D-window” chapter of the “Aerial triangu-
lation” User Manual)
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FunctionMenu items
to delete points out of useful areas (with specified
background color) (used mainly during automatic
points measurements on spaceborne images)

Delete points outside useful areas

to delete points of selected types from near-bound-
ary areas of project images marked in the list (see

Delete border points

the “Deleting points at image boundaries” chapter
of the “Aerial triangulation” User Manual)
to delete tie points duplicates (see the “Removing
point duplicates” chapter of the “Aerial triangulation”
User Manual)

Delete duplicated points

contains menu items used to import of triangulation
points measurements from files of PAT-B, X-Points

Import

formats from PHOTOMOD 4.x (XPT) projects, as
well as data import from flight path file (see the
“Import of triangulation points” chapter of the “Aerial
triangulation” User Manual)
contains menu items used to export of triangulation
points measurements to files of PAT-B and X-Points

Export

formats, and for export of ties or GCP for further
use them in Geomosaic module (see the “Export of
triangulation points” chapter of the “Aerial triangula-
tion” User Manual)
to open the Exterior orientation data list (see the
“List of exterior orientation parameters” chapter of
the “Aerial triangulation” User Manual)

List of exterior orientation parameters

to perform export of list of source exterior orientation
parameters and adjustment results to PAT-B and

Export exterior orientation...

CSV formats (see the “Export of exterior orientation
parameters” chapter of the “Aerial triangulation”
User Manual)
to load projection centres data as vector point ob-
jects and to open them in 2D-window to perform

Load projection centres as vectors

analysis, at that an image name is saved to the Name
point attribute
to perform export of georeference data after prelim-
inary block exterior orientation and adjustment (to
files of ArcInfo World FileandMapInfo TABformats)

Create images georeferencing files

to select part of block images to perform adjustmentSelect subblock
to specify adjustment parameters and to perform
block adjustment without using the theAdjustment
toolbar (see the “Block adjustment” User Manual)

Adjustment in batch mode

28

Processing of UAS data (Windows x64)PHOTOMOD 8.1

measurement.pdf
measurement.pdf
measurement.pdf
measurement.pdf
measurement.pdf
measurement.pdf
measurement.pdf
measurement.pdf
solver.pdf


3.7. The “Terrain” menu
Table 11. Brief description of the Terrain menu

FunctionMenu items
The Points menu contains usual menu items used
for automatic points measurement, filtering, import

Points

and export (see the “Points” chapter of the “Creating
DTM” User Manual)
The TIN menu contains menu items used to load
and save TIN layers, as well as to perform different

TIN

operations on creation, editing and accuracy control
of TIN building
TheDEMmenu contains standardmenu items used
to load and save DEM layers, as well as menu items

DEM

used to perform various operations on DEM cre-
ation, accuracy control, filtering and editing
allows to calculate a volume (i.e. embankment or
excavation) located between DEM surface and ar-

Compute volumes

bitrary Z-plane or in a more complex case, the
volume which is the overlap between the two
(roughly, “top” and “bottom”) DEM or TIN surfaces
(see the “Volumes calculation” chapter of the “Cre-
ating DTM” User Manual)
The Contours menu contains usual menu items
used for contours generating, editing, import and

Contours

export (see the “Contour lines” chapter of the “Cre-
ating DTM” User Manual)
The LASmenu contains usual menu items used for
converting the LIDAR data to DEM which is saved

LAS

into the file of active profile (see the “LIDAR Data
processing” User Manual)
The 3D-Modmenu allows to runmodule for creation
3d-objects based on 2D-vectors (see the “Three-
dimensional modeling” User Manual)

3D-Mod

3.7.1. The “TIN” menu

The TINmenu contains standard menu items used to load and save TIN layers, as well
as to perform different operations on creation, editing and accuracy control of TIN
building.

The Points menu is located in the Terrain menu.

Table 12. Brief description of the “TIN’$QUOTE$"menu

FunctionThe TIN menu
to load TIN from *.x-tin file (see the “TIN loading”
chapter in “DTM Generation” User Manual)

Load TIN... (Ctrl+O, T)
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FunctionThe TIN menu
to perform the quick access to recently loaded TIN
files

Recent

to save or rewrite active TIN layer as file with *.x-
tin extension (see the “TIN saving” chapter in “DTM
Generation” User Manual)

Save

to save active TIN layer with new name as file with
*.x-tin extension (see the “TIN saving” chapter in
“DTM Generation” User Manual)

Save as...

to close TINClose
to close all opened TIN layersClose all opened layers
contains menu items which allow to perform batch
management of TIN layers visibility in the Layer
manager

Layers visibility

to create TIN using loaded base layers (see the
“Building TIN” chapter in “DTM Generation” User
Manual)

Build (Ctrl+N, T)

to create textured 3D-TIN surfaces (see the “Cre-
ation of textured TIN 3D surface” chapter in “DTM
Generation” User Manual)

Build 3D-TIN...

to create textured 3D-TIN surfaces in batch mode
(see the “Batch 3D-TIN creation” chapter in “DTM
Generation” User Manual)

Build 3D-TIN (Batch mode)

to change coordinate system of 3D-TIN (see the
“Transformation of 3D-TIN coordinate system”
chapter in “DTM Generation” User Manual)

Convert 3D-TIN CS

contains menu items which can be used to filter
DEMs (see the “TIN filtering” chapter in “DTM Gen-
eration” User Manual)

Filter

Contains menu items to export results of TIN cre-
ation to DXF and CSV formats (see the “Export TIN”
chapter in “DTM Generation” User Manual)

Export

Contains menu items allowing to import TIN from
different formats (see the “Import TIN” chapter in
“DTM Generation” User Manual)

Import

contains the Additional menu (see below)Additional

Table 13. Brief description of the “TIN’$QUOTE$"menu (additional)

FunctionThe TIN menu
to restore TIN from contours (see the “TIN restoring”
chapter in “DTM Generation” User Manual)

Restore...

to create TIN border in automatic mode (see the
“TIN borders creation” chapter in “DTMGeneration”
User Manual)

Compute border

to rebuild TIN after editing of base layer objects (see
the “TIN re-building” chapter in “DTM Generation”
User Manual)

Rebuild
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FunctionThe TIN menu
to control TIN creation accuracy by triangulation
points (see the “Check against adjustment points”
chapter in “DTM Generation” User Manual)

Check against adjustment points

to control TIN creation accuracy by vector objects,
which were not used during TIN creation (see the

Check against vector objects

“Check TIN against vector objects” chapter in “DTM
Generation” User Manual)
to check topology of TIN creation (see the “Verifying
of TIN topology” chapter in “DTM Generation” User
Manual)

Verify topology...

to calculate TIN surface area within a polygon (see
the “TIN area info” chapter in “DTM Generation”
User Manual)

The area of a polygon on the surface

to calculate TIN projection area on plane and area
of TIN 3D surface (see the “TIN area info” chapter
in “DTM Generation” User Manual)

Calculate area

to view statistic information about TIN (see the
“General TIN info” chapter in “DTM Generation”
User Manual)

Statistic

to interpolate TIN to smooth DTM in order to build
or enhance contour lines (see the “Smooth TIN in-

Interpolate

terpolation” chapter in “DTM Generation” User
Manual)
to convert TIN into a vector layer (see the “Convert-
ing TIN into a vector layer” chapter in “DTM Gener-
ation” User Manual)

Convert to vector layer

to embed vector objects layer to created TIN (see
the “Insert objects into TIN” chapter in “DTMGener-
ation” User Manual)

Embed objects

Contains menu items to export results of TIN cre-
ation to DXF and CSV formats (see the “Export TIN”
chapter in “DTM Generation” User Manual)

Export

Contains menu items allowing to import TIN from
different formats (see the “Import TIN” chapter in
“DTM Generation” User Manual)

Import

to enable/disable editable TIN layer visibilityOn/Off TIN visibility (Ctrl+T)

3.7.2. The “DEM” menu

The DEM menu contains standard menu items used to load and save DEM layers, as
well as menu items used to perform various operations on DEM creation, accuracy
control, filtering and editing.

The DEM menu is located in the Terrain menu.
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Table 14. Brief description of the DEM menu

FunctionMenu items
to load DEM from *.x-dem file (see the “DEM load-
ing” chapter in “DTM Generation” User Manual)

Load DEM... (Ctrl+O, D)

to load DEM from external data without its conver-
sion to internal format (see the “DEM loading”
chapter in “DTM Generation” User Manual)

Open from file...

to perform the quick access to recently loaded DEM
files

Recent

to save opened DEM to a new file (see the “DEM
saving” chapter in “DTM Generation” User Manual)

Save copy

to save DEM area (see the “DEM saving” chapter
in “DTM Generation” User Manual)

Save selection

to close DEMClose
to close all opened DEM layersClose all opened layers
contains menu items which allow to perform batch
management of DEM layers visibility in the Layer
manager

Layers visibility

contains menu items used to create DEM with help
of various source data (see the “DEM creation”
chapter in “DTM Generation” User Manual)

Build DEM...

contains menu items which can be used to filter
DEMs (see the “DEM filtering” chapter in “DTM
Generation” User Manual)

Filter

contains menu items used to restore blank cells of
DEM using various methods (see the “Null cells in
DEM” chapter in “DTM Generation” User Manual)

Fill null cells

contains items used to import DEM from files with
*.grd, *.asc, *.tif, *.dem, *.mtw, *.dt1, *.dt2,

Import...

*.img, *.pix, *.hgt extensions (see the “DEM im-
port” chapter in “DTM Generation” User Manual)
to simultaneous import of multiple DEM (see the
“Batch DEM import” chapter in “DTM Generation”
User Manual)

Batch import

to simultaneous import of multiple DEM from a
specified folder (see the “Batch import from folder”
chapter in “DTM Generation” User Manual)

Batch import from folder

contains menu items used to perform export of DEM
to different formats (see the “DEM export” chapter
in “DTM Generation” User Manual)

Export...

contains the Additional menu (see below)Additional
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Table 15. Brief description of the DEM menu (additional)

FunctionMenu items
to save a DEM as a raster file with geodetic refer-
ence (see the “DEM saving” chapter in “DTM Gen-
eration” User Manual)

Save as georeferenced raster...

contains menu items used to create DEM with help
of various source data (see the “DEM creation”
chapter in “DTM Generation” User Manual)

Build DEM...

to recreate DEM after changing of TIN base layer
(see the “DEM creation by TIN” chapter in “DTM
Generation” User Manual)

Rebuild by TIN

to restoring of DEM consistency, which may be
disrupted by applying various operations or DEM

Restore

filtering (see the “DEM recovering” chapter in “DTM
Generation” User Manual)
to filter objects based on slope angle (see the “Slope
based filter” chapter in “DTM Generation” User
Manual)

Slope based filter

to filter DEMs depending on image characteristics
(see the “Filter by image properties” chapter in “DTM
Generation” User Manual)

Filter by image properties

to correct DEM cell values along the selected linear
objects (see the “Elevation correction along axis
line” chapter in “DTM Generation” User Manual)

Correct along vector line

to convert DEM cells with specified elevation to null
cells (see the “Converting cells to null” chapter in
“DTM Generation” User Manual)

Cut DEM by Z-range

to set the same elevation of DEM cells inside and
outside of selected polygons (see the “Change DEM

Set elevation in selected polygons...

parts elevation” chapter in “DTM Generation” User
Manual)
to interpolate a value of DEM cells inside and out-
side of selected polygons (see the “DEM interpolat-
ing” chapter in “DTM Generation” User Manual)

Interpolate elevation in selected polygons...

to edit coverage area of DEM (see the “DEM cutting
by polygons” chapter in “DTM Generation” User
Manual)

Cut by selected polygons

to remove edge areas of DEM, that include blank
cells (see the “DEM cutting by polygons” chapter in
“DTM Generation” User Manual)

Cut null edges

to transpose DEM from the left coordinate system
to the right one and vice versa (see the “DEM

Transpose

transpose” chapter in “DTM Generation” User
Manual)
to change coordinate system of DEM (see the
“Transformation of DEM coordinate system” chapter
in “DTM Generation” User Manual)

Transform to another coordinate system
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FunctionMenu items
to change coordinate system of multiple DEMs (see
the “Batch transformation of DEMs coordinate sys-
tem” chapter in “DTM Generation” User Manual)

Batch transform to another coordinate system

to recreate DEM considering results of the last ad-
justment (if the project was adjusted after DEM

Rebuild considering last adjustment

creation once more – see the “Rebuilding DEM
considering last adjustment” chapter in “DTM Gen-
eration” User Manual)
to parallel displacement of DEM by axes (see the
“DEM shift” chapter in “DTM Generation” User
Manual)

Shift

to split DEM into sheet to save DEM in parts in
separate files (see the “Split DEM into sheets”
chapter in “DTM Generation” User Manual)

Split DEM into sheets

to merge DEMs, that have overlap area (see the
“DEM merging” chapter in “DTM Generation” User
Manual)

Merge DEMs

to perform accuracy control DEM creation using
various data (see the “Accuracy control of DEM
creation” chapter in “DTMGeneration” User Manual)

Accuracy control

to calculate a volume (i.e. embankment or excava-
tion) located between DEM surface and arbitrary

Compute volumes

Z-plane or in a more complex case, the volume
which is the overlap between the two (roughly, “top”
and “bottom”) DEM surfaces (see the “Volumes
Calculation” chapter in “DTM Generation” User
Manual)
to calculate a slope map (see the “Slopes map cre-
ation” chapter in “DTM Generation” User Manual)

Calculate slope map

to convert DEM cells to points with specified simpli-
fying (see the “Convert DEM to points” chapter in
“DTM Generation” User Manual)

Convert to points...

to convert DEM to LAS point cloud (see the “Convert
DEM to point cloud (LAS)” chapter in “DTM Gener-
ation” User Manual)

Convert to LAS

to add points to DEM that helps to refine DEM cells
values (see the “Adding of points to DEM” chapter
in “DTM Generation” User Manual)

Write points to DEM

3.7.3. The “Contours” menu

The Contoursmenu contains usual menu items used for contours generating, editing,
import and export.

The Contours menu is located in the Terrain menu.
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Table 16. Brief description of the Contours menu

FunctionMenu items
to load contour lines from *.x-data file (see the
“Vectorization” User Manual)

Load... (Ctrl+O, V)

to perform the quick access to recently loaded con-
tour lines

Recent

to save or rewrite active contours layer (see the
“Saving contour lines” chapter in “DTMGeneration”
User Manual)

Save

to save active layer with new name (see the “Saving
contour lines” chapter in “DTM Generation” User
Manual)

Save as...

to save just selected contours (see the “Saving
contour lines” chapter in “DTM Generation” User
Manual)

Save selected as...

to close contour lines layerClose
contains menu items used to create contour lines
with help of various source data (see the “Contour

Build contours

lines generation” chapter in “DTMGeneration” User
Manual)
contains items used to import contour lines from
files with different extensions (see the “Import of

Import

vector objects” chapter of the “Vectorization” User
Manual)
contains menu items used to perform export of
contour lines to files with different extensions (see

Export

the “Export of vector objects” chapter of the “Vector-
ization” User Manual)
to save, edit, and export contours within the given
notation sheets to the Panorama format (see the

Prepare/export contours sheets

“Export of contours sheets” chapter in “DTMGener-
ation” User Manual)
contains the Additional menu (see below)Additional

Table 17. Brief description of the Contours menu (additional)

FunctionMenu items
contains menu items used to create contour lines
with help of various source data (see the “Contour

Build contours

lines generation” chapter in “DTMGeneration” User
Manual)
to check created contours for crossing/self-crossing,
that occur after operation of contours smoothing

Check contours intersections...

(see the “Control of contours crossing” chapter in
“DTM Generation” User Manual)
to perform quality control of contours creation using
regular points, if they were not used for contours

Check contours by points

creation (see the “Check contours by points” chapter
in “DTM Generation” User Manual)

35

Processing of UAS data (Windows x64)PHOTOMOD 8.1

vectorization.pdf
DEM.pdf
DEM.pdf
DEM.pdf
DEM.pdf
vectorization.pdf
vectorization.pdf
vectorization.pdf
DEM.pdf
DEM.pdf
DEM.pdf
DEM.pdf
DEM.pdf


FunctionMenu items
to merge created contours in automatic or manual
mode (see the “Contours merging” chapter in “DTM
Generation” User Manual)

Merge contours...

to check contours for breaks that occur after manual
or automatic contours merging (see the “Check of

Check merging contours...

contours merging quality” chapter in “DTMGenera-
tion” User Manual)
to connect created contours automatically or
manually (without merging into a single vector ob-

Contours connecting

ject – see the “Contours connecting” chapter in
“DTM Generation” User Manual)
to check elevations of created contours vertices
(see the “Check elevations of contours vertices”
chapter in “DTM Generation” User Manual)

Check contours vertices

to set a precision of vector objects coordinates at
level of decimal places (see the “Precision of objects

Precision of objects coordinates

coordinates” chapter in “DTM Generation” User
Manual)

3.8. The “Vectors” menu

See the “Vectorization” User Manual.

3.9. The “Raster” menu

The system provides theRastermenu to perform various operations with raster images.

Table 18. Brief description of Raster menu

FunctionMenu items
to create orthophoto production and mosaicking
(see the “Orthorectification” User Manual)

Orthorectification

to run the GeoMosaic program allows to create the
orthomosaic from georeferenced orthorectified aer-

GeoMosaic

ial and satellite imagery, splitting of created ortho-
mosaic with the capable of saving sheets in popular
raster file format (see the “Orthophotomaps creation”
User Manual)
to launch the Raster Converter program for prepar-
ing and converting raster images into the internal

Raster Converter

format files and then for placing them in active profile
resources (see the “General information” User
Manual).
to edit path to image files (see the “ImageWizard
Adjustment of images” chapter in “Creating project”
User Manual)

ImageWizard module

to load georeference images from folder inWindows
file system (see the “Georeferenced external data”

Load georeferenced images (files)
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FunctionMenu items
section of the “Aerial triangulation” User Manual and
the “Pseudo-stereo mode” section of the “Vectoriz-
ation” User Manual)
to load georeference images from active profile re-
sources (see the “Georeferenced external data”

Load georeferenced images (resources)

section of the “Aerial triangulation” User Manual and
the “Pseudo-stereo mode” section of the “Vectoriz-
ation” User Manual)
to load georeferenced web-maps from the Internet
(see the “Web-map loading” chapter in “Creating
project” User Manual)

Load web-map

to use one of three modes of displaying raster im-
ages in 2D-window: Cached only (Ctrl+Shift+1),

Show rasters

Depending on zoom (Ctrl+Shift+2) or Source
only (Ctrl+Shift+3)
contains the Additional menu (see below)Additional

Table 19. Brief description of Raster menu (additional)

FunctionMenu items
to perform georeferencing images by geodetic co-
ordinates GCP points, obtained from vector/raster

Image georeferencing

maps or from a list of file *.txt (see the “Orthopho-
tomaps creation” User Manual)
to perform affine correction of georeferenced images
(see the “Affine georeference correction” chapter in
“Creating project” User Manual)

Affine georeference correction

to save a georeference raster image of the active
layer with specified parameters in output file format

Save raster layer

(TIFF, MS-TIFF, MegaTIFF – see the “Saving of
raster image” chapter in “Creating project” User
Manual)
to close all opened raster layersClose all opened layers
contains menu items which allow to perform batch
management of raster layers visibility in the Layer
manager

Layers visibility

to run the ScanCorrect program for compensation
of metric errors occurred when scanning graphical

ScanCorrect

data on flatbed polygraphic scanners (see the
“ScanCorrect program” User Manual)
to ’clean’ images of dust particles, photo emulsion
defects etc (see the “Dust Correct” chapter in “Cre-
ating project” User Manual)

Dust Correct

to delete raster cache from RAMClear cache
to rearrange block images by z-orderImages order
to rebuild image pyramids for MegaTIFF images
(see the “Image pyramid creation” chapter in “Cre-
ating project” User Manual)

Rebuild Mega Tiff pyramids
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FunctionMenu items
to set zoom of images in 2D-window by set GSD in
pixels

Adjust zoom

3.10. “Service” menu
Table 20. Brief description of the Service menu

FunctionMenu
to open the PHOTOMOD Explorer module to view
resources system (see the “PHOTOMOD Explorer

Explorer

module. Resources management” chapter in “Gen-
eral information” User Manual)
to launch the GeoCalculator program that is used
for coordinates transformation form one reference
system to another

GeoCalculator

to run the GIS Panorama Mini (this software is not
included with the PHOTOMOD but can be installed
separately)

GIS Panorama

to display area on images in the GoogleMaps ser-
vice (Internet connection required); it is possible

Show in Google Maps

only for projects in geodetic coordinate systems or
if the coordinate system could be transformed to
geodetic
to display area on images in the YandexMaps ser-
vice (Internet connection required); it is possible

Show in Yandex Maps

only for projects in geodetic coordinate systems or
if the coordinate system could be transformed to
geodetic
to refresh 2D-window and fit displayed area depend-
ing on load data

Recalc working area

to turn on/off defined mouse driverActivate mouse driver
to setup or connect mice, including special mice,
hand wheels and foot pedals, and also to macros

Mouse setup

setup (see the “Using of special mice, hand wheels
and foot pedals in the system” chapter in “General
information” User Manual)
to cancel the last operation of vector objects editing
on a layer (see the “Undo editing operations” chapter
in “Vectorization” User Manual)

Undo (Ctrl+Z)

o open the Undo log containing a list of recent
editing operations (see the “Undo editing operations”
chapter in “Vectorization” User Manual)

Undo log

to redo the last undone operation (see the “Undo
editing operations” chapter in “Vectorization” User
Manual)

Redo (Ctrl+Shift+Z)

to display the last log of system actionsLast log
to open the window to set the general parameters
of the system

Parameters
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FunctionMenu
contains the Additional menu (see below)Additional

Table 21. Brief description of the Service menu (additional)

FunctionMenu
contains menu items to run, test and setup distrib-
uted processing (see the “Distributed Processing”
chapter in “General information” User Manual)

Distributed Processing

to choose working coordinate system (see the Pro-
ject creation User Manual)

Working coordinate system

to detect the Gauss-Krueger zone automatically for
the selected object, provided that anyGlobal coordin-

Autodetect Gauss-Krueger zone

ate system is used (see the “Automatic detection of
theGauss-Krueger zone” chapter in “General inform-
ation” User Manual)
to launch the CSV converter to transform points
coordinates in CSV and TXT files and also for other

CSV converter

transformations for CSV files (see the “CSV convert-
er” chapter in “General information” User Manual)
to load the World map to a new vector or raster
layer (see the “Loading atlas” chapter in “General
information” User Manual)

Load atlas

to save visible part of images in active 2D-window
as a raster image with specified size and quality

Save scene

to adjust hotkeys using in the system, edit, delete
or create new hotkeys (see the “Customize hotkeys”
chapter in “General information” User Manual)

Customize hotkeys

to use so called shortcut commands, the custom
button combinations for quick access to various

Customize fast commads

functions when working with the layers such as
Vectors, DEM, Raster, Grid, or TIN (see the
“Shortcut commands” chapter in “General informa-
tion” User Manual)
to save projects parameters and use it automatically
when restart the system

Save options
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If the GIS Panorama executable file is not found, an appropriate system message will
appear. The software description and URL hyperlink (for download) are indicated in
this message.

Click Yes to go to path settings (see the “Paths settings” chapter of the “General system’s
parameters” User Manual.

3.11. The “Windows” menu
Table 22. Brief description of the Windows menu

FunctionMenu items
to open window with a block schemeNew 2D-window (block)
to open window with a stereopairNew 2D-window (stereopair) (Ctrl+Alt+W)
to open the 3D-window (see the “General informa-
tion” User Manual)

3D-window

to open marker parameters window (see the “’Vec-
torization” User Manual)

Marker window (Ctrl+Alt+C)

to open window that allows to perform measure-
ments by images (see the “Vectorization” User
Manual)

Measurements window (Ctrl+Alt+D)

to open the Classifier window to show set of
standard vector objects attributes (see the “Classifier

Classifier

$QUOTE$" chapter in the “Vectorization” User
Manual)
to open the Attributes window to display attributes
of selected vector objects (see the “Vector objects

Objects attributes

attributes $QUOTE$" chapter in the “Vectorization”
User Manual)
contains menu items allows to open additional tool-
bars

Toolbars

contains the Additional menu (see below)Additional

See detailed description of the system’s windows in the “General information about the system”
User Manual.

To get quick access to themainwindows of the system, selectWindows › Toolbars › Windows.
TheWindows toolbar is opened.

Table 23. Brief description of the ’ Windows ’ menu (Additional)

FunctionMenu items
to open block editor window (see the ’Project cre-
ation’ User Manual)

Block editor

to open the block layout window (see the ’Aerial tri-
angulation’ User Manual)

Block layout

to show all toolbarsShow all toolbars
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FunctionMenu items
to show all opened toolbars in visible part of the
screen

Find all toolbars

to hide/show all opened toolbarsTemporarily hide toolbars (TAB)
to open the Images list window (see the ’Creating
project’ User Manual)

Image list...

to open window with image selected on a block
scheme

New 2D-window (single image)

to open all 2D-windows with marker place. Press
and hold Alt key while clicking the menu item to

Open image under marker

open images with 1:1 zoom , otherwise, full images
are displayed
to close all 2D-windows with imagesClose all single image windows
to refresh information in all opened 2D-windowsRefresh all 2D-windows
to close all 2D-windowsRefresh all 2D-windows
contains menu items allow to arrange opened 2D-
windows in a work area with one of the following
ways:

Arrange

• Tile – to tile 2D-windows;

• Row – to row 2D-windows;

• Column – to column 2D-windows;

• Stack – to stack 2D-windows;

• Arrange 2D-windows in a tabsheet;

• Evenly – to arrange 2D-windows evenly.

contains menu items allows to move to other stereo-
pairs (see the ’Vectorization’ User Manual)

Stereopairs

to show table with triangulation points coordinatesTriangulation points coordinates
to choose triangulation points to displayTriangulation points view control
to open contours classifier window to edit paramet-
ers of contours display (see the ’DTM generation’
User Manual)

Contours classifier table

to display list of active layer vector objects (see the
’Vectorization’ User Manual)

Objects list

to set on the mode allows to movemarker in stereo-
pair 2D-window in pixel coordinates

Marker motion in pixel coordinates

to zoom in all 2D-windowsZoom all in (Shift+* NumPad)
to zoom out all 2D-windowsZoom all out (Shift+/ NumPad)
to use a viewmask for active layer (see the ’General
information’ User Manual)

Layer view mask

to view list of opened 2D-windowsWindows list
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Appendix A. Preparing to work

A.1. Program start

Prior to work in the program, it is needed to insert Sentinel HL unique security key into
the USB-socket of the workstation. The security key drivers should be installed on the
workstation (see “Protection of the system” chapter of “General information” User
Manual).

To start the program do the following:

1. Perform one of the following actions:

• choose the Start › Programs › PHOTOMOD UAS 8 x64 › PHOTOMOD UAS 8
x64 to run PHOTOMOD UAS installed as a separate software;

• to start PHOTOMOD UAS as PHOTOMOD system module, choose the Start ›
Programs › PHOTOMOD 8 x64 › PHOTOMOD UAS 8 x64.

2. [optional] Prior to work in the program you should create a profile for placing project
resources such as project configuration files, images files, processing results.

Profile creation is performed during the first launch of PHOTOMOD UAS program
or in the Control Panel module (see the “Control Panel. Profiles management”
chapter of the “General information” User Manual).

3. Wait until the System Monitor module starts. The icon in the Windows system
tray appears. Wait until PHOTOMOD UAS main window opens.

If the System Monitormodule is already launched – choose PHOTOMOD UAS item in the
context menu of this module (the icon in theWindows system tray), to open previously
closed PHOTOMOD UAS user interface.

4. The Project management window opens in PHOTOMOD UAS user interface:
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Fig. A.1. The Project management window

To close the Project management window clickW/o project button.

The New project window also opens automatically if there is no existed projects in the
active profile. Click Cancel to close it.

5. The main PHOTOMOD UAS window in ready for processing:
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Fig. A.2. The main PHOTOMOD UAS window (without project)

A.1.1. Choosing active profile

This step is optional.

During one work session of the program could be used only one active profile. User
can change the active profile before project creation, if PHOTOMOD UAS software is
already configured and connected to existing profiles and resource systems.

A.1.1.1. Brief description of data storage organization

See detailed description in “Prepare to processing” chapter of the “General information” User
Manual).

Resources system is a way to store data with possibility of network distributed project
processing. Operator has access for an unified system with all available profiles, regard-
less of the PC used for data storage and processing.
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The following main definitions are used in the resources system:

• Profile – independent group of resources relative to one or several projects;

• Virtual folders is a virtual names of real local/network folders (hard disks) or group
of folders, chosen by user to store profile resources.

One profile can use data located on several computers.

Configuration of resources depends on profile settings. Profile has a virtual name and
do not equal to real file system. This name is a common root of the resources tree that
connects all branches (resources) profile. The tree have the following structure:

• Root – profile virtual name.

• Top level branches – profile virtual folders – virtual names of physical local or network
folders/disks.

One physical folder could be specified as a virtual folder.

• Resources – the whole content of selected folder of a profile – all subfolders and
files. Only images source files from active profile resources could be matched with
images of current project.

Profiles can be local or network to organize individual or shared work with projects, re-
spectively. Configuration files that describe a set of local profiles and its structure are
stored in the PHOTOMODUAS8.VAR folder.

For profiles creation and organizing resources structure of each profile you can use the
Control Panel module. To view and edit active profile resources is used the PHOTOMOD
Explorer module.

To launch these modules is used the Start › Programs › PHOTOMOD UAS 8 x64
menu and also the context menu of the System Monitor module (the icon in the
Windows system tray).

A.1.1.2. Changing active profile

Close all program modules (except System Monitor) and perform one of the following
actions to change the active profile:

• choose active profile in the Profile list in the context menu of the System Monitor
module (the icon in the system tray);
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• choose the Control Panel menu item in the context menu of the System Monitor
module. TheControl Panelmodule opens. Select the active profile with mouse double-
click by profile name in the Profile list in the Control Panel module window.

Fig. A.3. The Control Panel module window

Current active profile is marked in the profile list by the icon.

Restart all program modules after changing the active profile (to do this, choose Exit
item in the context menu of SystemMonitormodule, close all opened program windows
and run PHOTOMOD UAS again). All resources in the active profile are available for
use until another active profile is selected.

A.2. Image preparing
Data preparation, i.e. converting images into the internal PHOTOMOD format and loading them
into the internal resource system is an optional (and recommended) stage of data processing.
The system provides for loading unprepared images into the project directly from theWindows
file system. However, the further description of project processing implies processing of prepared
images loaded into the active profile resource system.

Prior project creation it is recommended to prepare UAS images using the Raster
Converter module.

46

Processing of UAS data (Windows x64)PHOTOMOD 8.1



Raster Converter is a service systemmodule that could be used to batch and sequence
conversion of raster files to inner MS-TIFF format with LZW or JPEG conversation or
without it and to convert MS-TIFF images to different formats.

For working with images in program, it is recommended to use MS-TIFF internal raster
format, which is the TIFF format with overview pyramid (set of subsampled images
copies) for higher image display performance.

The system allows the direct use of various formats of raster images (without having to convert
them). It saves the disk space, but slows down significantly operations with images, so it is
strongly recommended to use raster images in MS-TIFF format.

In case of processing amount of images places on different data medium and take much disk
space, it is recommended to preliminary prepare raster images with module before creation of
a project.

To start the module perform one of the following:

• choose Start › Programs › PHOTOMOD UAS 8 x64 › Raster Converter;

• choose Rasters › Raster Converter;

• choose Raster Converter in the right-click menu of the System Monitor module (the
icon in the Windows system tray).
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Fig. A.4. Raster converter window

The recommended workflow for the central projection project images:

See the full Raster Converter module description in the “General information” User Manual.

1. [if necessary] Perform the radiometric correction;

2. Convert the images to files of inner MS-TIFF format;

3. [optional] It is recommended to apply JPEG compression with 85 % quality for
output files to save place on hard disk;

4. Choose an individual folder in PHOTOMOD resources as the output folder for
the converted images.

Further, when creating a project (after converted images have been saved), do not place
it in the folder with images. The most optimal solution is to place the project and the con-
verted images in two different folders in the resource system.
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Appendix B. UAS project processing sequence
PHOTOMODUAS is intended to work exclusively withCentral projection project types
(see the “Project types” section of the “Creating project” User Manual). The project
processing process may vary depending on the features of the input data and the re-
quired results.

Processing of PHOTOMOD UAS project implies performing the following main steps:
Aerial Triangulation, Compute DEM and Compute Orthophoto. The appropriate
main toolbar tabs names, layout and content displays the main steps of UAS data pro-
cessing workflow (see Section 3.2.1).

KeyPHOTOMODUAS functionalities similar to correspondingPHOTOMOD instruments
(aerial triangulation, vectorization, DEM creation, and orthophoto) are described in the
appropriate sections in manuals from the main PHOTOMOD documentation package
(see Section 3.3).

Possible procedure options are shown below as diagrams. A step-by-step example of
project processing is given in Appendix C.

Fig. B.1. UAS project processing sequence (Triangulation)

Fig. B.2. UAS project processing sequence (DTM building)

Fig. B.3. UAS project processing sequence (Compute orthophoto)
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Fig. B.4. Presumed workflow of UAS processing
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Fig. B.5. Presumed workflow of UAS processing
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Appendix C. UAS project processing example
This section discusses the most common algorithm for processing a UAS project. More detailed
user manual, including those that consider non-standard situations that arise during data pro-
cessing, are contained in the main PHOTOMOD documentation.

C.1. Project creation and images adding
See details about central projection project creation in the “Project creation” User Manual.

In order to create UAS project perform the following actions:

1. Start the PHOTOMOD UAS program;

2. Open the New project window using one of the following ways:

• choose Project › Open/Manage... (Ctrl+Alt+O). The Manage project window
opens. Click the New button;

• choose Project › New.

TheNew projectwindow opens automatically if there is no existed projects in the active
profile.

Fig. C.1. Creating UAS project.

3. Define a Name of new project.
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4. [optional] Input to the Description section a brief project description, its main fea-
tures, notes etc.

5. In theCoordinate system section click the Select button. Project coordinate system
could be chosen from the following sources:

• From DB: International, Local – used for coordinate system choosing from in-
ternational or local database.

• From file – used to load a coordinate system from the *.x-ref-system file (if
any), placed outside from active profile resources.

• From resource – used to load a coordinate system from the *.x-ref-system file,
located in active profile resources (from another project of active profile, for in-
stance);

• From GeoCalculator – from the list of GeoCalculator program database (see
the “Coordinate Systems” chapter in “The GeoCalculator program” User manual).

The GeoCalculator program allows to edit coordinate systems, to create new ones, to
perform import and export of coordinate systems (see the “The GeoCalculator program”
User Manual).

When choosing coordinate system from database theCoordinate systemdatabase
opens, which contains the list of coordinate systems.

Fig. C.2. Window used to select coordinate system from coordinate system database

To perform fast search for coordinate system, input the whole coordinate system name or
its part to the Find input filed.

53

Processing of UAS data (Windows x64)PHOTOMOD 8.1

geocalc.pdf
geocalc.pdf


To choose geoid to be used, click the button. Select proper type of geoid usage:

• No geoid;

• EGM 96.

The system allows to use the EGM2008 geoid. See more details in the “Installation
EGM2008 Geoid” User Manual. After installation the geoid is displayed in the list.

PHOTOMOD GeoCalculator provides for creating a user height system (geoid) with
preset parameters. PHOTOMOD system allows to use previously created custom ver-
tical datum (geoid). See instructions in the “Creating custom height system” chapter of
“The GeoCalculator program” User Manual.

6. [optional] Set the Relief elevation checkbox and specify approximate difference
of terrain heights on project images in the min and max input fields.

If the relief elevation data is unavailable or inaccurate by the time of project creation, the
system allows to define the value later in project properties. Terrain elevation data is used
to refine a block layout, it is considered during import of exterior orientation parameters
and during calculation of ground sample distance (GSD).

If the Relief elevation was not indicated while project creation, it is in any case will be set
when importing exterior orientation elements (see the “Aerial triangulation” User Manual).

7. In the Project path list choose a folder of active profile resources to place project
files there.

Only folders of two upper levels could be used to place project files into the Project path
list (virtual folders and their subfolders), which do not contain images files. To edit structure
of profile resources use the PHOTOMOD Explorer module (see the “General information”
User Manual).

Virtual folders connection to network profile is performed only in theControl Panel module.
After update of profile resources structure click the button to refresh the list in the Project
path section.

The search field that allows to Find a project in the list by its name or name part is situated
below the Project path list. F3 key allows to focus marker on the search field. Press F3
again to focus marker on the next found project in the list.

The Full project path input field will show the project name and full path.
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8. Click OK to complete a project creation. After that service folders and configuration
files are created in the specified project folder. The first strip create automatically
(see below).

It is possible to use the distributed processing mode during project creation. For
this, perform the following:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing button.

9. The New strip window opens:

Fig. C.3. The New strip window

10. Define Name of the strip.

11. Click OK. New strip creates and its frame displays in block scheme 2D-window.
The Block editor window opens (see below). The row with name of strip displays
in the table of the Block editor window.

C.1.1. Adding images from resources

Refer to the “Images block forming” chapter of “Project creation” User Manual for the detailed
description of images loading from files and from resources, images setup and images block
editing.

Perform the following actions to load prepared images to a project from the active profile
resources and to form an images block:

1. Click From resources button in Triangulation tab of the main program toolbar
(or click the button in Block editor window toolbar).
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Fig. C.4. The Block editor window

2. Choose prepared images files and click the Open button. After that all images are
loaded to the first strip.

To filter showing files choose Image in TIFF format in the list rightward to the Resources
name field.

To add images from theWindows file system – click From files button in Triangulation
tab of the main program toolbar (or choose Block › Add images from files).

C.2. Interior orientation
This section briefly describes the process of interior orientation of images obtained by a digital
camera. It covers importing interior orientation data from metadata (if available) and setting up
camera parameters (if it is not possible to import data).

The detailed description of the process of interior orientation of images (including images obtained
by an analog camera) see in the “Interior orientation” section of the “Aerial triangulation” User
Manual.

Interior orientation of image acquired by digital camera is to determine the principal
point position relative to the center of the lower left pixel of the image. Interior orientation
operation includes input or import of camera parameters, specifying of flight direction
and angle of camera axes rotation for images of a project.

C.2.1. Import from metadata

In most cases, source images acquired by digital camera, might contain metadata,
written in EXIF format. Metadata of converted source images (in TIF format or in system’s
internal format MS-TIFF) is stored in the folder, which contains these images, in separate
files with *.md extension.
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In both cases, if images containing metadata are available in a project, it is possible to
import from the metadata to the project parameters of interior orientation (precise) and
exterior orientation (approximate, i.e. calculated by on-board devices). In order to perform
interior orientation when metadata is available, perform the following actions:

Prior to orientation data import from images metadata it is recommended to specify height dif-
ference of terrain in the project in the Project properties window (see the “Project creation”
User Manual).

1. Choose Orientation › Import exterior orientation or click the Import from
metadata button on the Triangulation tab of the main porgram toolbar to get
camera data from EXIF-metadata in image files. The Import orientation from
metadata window opens:

Fig. C.5. Import orientation parameters from EXIF-metadata

2. Make sure that the Import interior orientation checkbox is set on.

The Import preliminary exterior orientation checkbox is also set by default, in order to
import exterior orientation parameters.

Exterior orientation parameters imported from images metadata allow to split a project on
strips using imported exterior orientation, rotate images by block layout using imported
data, adjust block scheme by imported exterior orientation parameters.

Set the Import EO angle values, if needed.

Angular exterior orientation parameters of image – parameters that define image angular
orientation in coordinate system of photogrammetric survey object, slope and rotation
angles of image.

To perform import of exterior orientation parameters it is necessary that a project is in co-
ordinate system consistent with WGS-84 coordinate system.

3. [optional] Set Replace existing data checkboxes, if the information about internal
and external orientation has always been imported into the system and data currently
imported is more preferable.
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4. Click OK.

[optional] To check the results of exterior orientation parameters import, perform the
following actions:

1. Choose Orientation › Manage cameras or click the Manage cameras button
on the Triangulation tab of the main program toolbar to adjust camera parameters
and define camera axes direction for project images. TheManage project cameras
window opens.

2. Choose camera in the list and click the button. The Camera window opens to
view and edit camera data:

Fig. C.6. The Camera window containing imported data

58

Processing of UAS data (Windows x64)PHOTOMOD 8.1



C.2.2. Manage cameras

In order to perform interior orientation when metadata is unavailable, perform the follow-
ing actions:

1. Choose Orientation › Manage cameras or click the button of main toolbar to
adjust camera parameters and define camera axes direction for project images.
The Manage project cameras window opens.

2. Choose camera in the list and click the button. The Camera window opens to
view and edit camera data.

3. [optional] Input camera additional data (if camera passport is available) and click
OK.

4. Specify flight direction using window of images preview inManage project cameras
window and define camera axes rotation for project images in the following way:

Fig. C.7. The Manage project cameras window

1. Choose images in the table which do not require axes rotation.

2. Set the Set camera rotation for selected images checkbox and specify a
rotation angle so, that Х axis coincides with flight direction.
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3. Click the Execute button. Interior orientation is performed automatically.

See detailed description of this interior orientation step in the “Project cameras management”
chapter of “Aerial triangulation” User Manual.

C.3. Exterior orientation
This user manual addresses the process of importing exterior orientation elements of images
from image metadata or from separate text files. For a detailed description of the exterior orient-
ation of images, see the “Exterior orientation” section of the “Aerial triangulation” User Manual.
A separate chapter below describes working with ground control points.

Exterior orientation parameters are coordinates of projection centres and 3 angles, that
allow to specify in whole real position of images in space.

Exterior orientation parameters may be included to EXIF-metadata of images files or
separately as a catalogue in a file of text format. Additional information about import of
preliminary exterior orientation data from EXIF-metadata is in Section C.2.

If exterior orientation parameters are available for UAS project, you can import them to the
project, together with Interior orientation parameters.

C.3.1. Import from file

In order to perform import of exterior orientation data catalogue from a file of text format,
do the following:

1. Choose Orientation › Additional › Exterior orientation data list or click the
Exterior orientation data list button on the Aerial Triangulation tab of the main
toolbar. The Exterior orientation parameters window opens.

2. Click the button to import exterior orientation parameters.

The button is duplicated by the Import from file button on the Triangulation tab of
the program main toolbar and theOrientation › Import exterior orientation...menu item.

3. Choose a file with exterior orientation parameters and click OK. The Exterior ori-
entation import – Step 1 of 3: File window opens. The File name input field dis-
plays selected file placement and name.

To select another file which contains exterior orientation parameters, click the button.
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Fig. C.8. The Exterior orientation import window (the file string template is not specified)

If the imported data contains information about time stamps, this information must be
presented in Unix time (POSIX time) format.

Unix time is represented by an integer that increments with each passing second. The in-
teger system used is convenient for comparing and storing dates.

If one needs to access date elements (day, month, year), seconds can be converted into
any suitable format (and vice versa). A signed integer type is used in programs to store
Unix time.

4. [optional] If images names in file and in project are not the same, perform one of
the following actions:

• set on the Loose matching of image names in file against names in project
checkbox. The program performs search for common substrings and matches
images names. For example, it searches for common substring 018_02595 in
image name RGBI_018_02595 in file and image name 018_02595 in project.

If the Loose matching of image names in file against names in project checkbox is
set on the image name with file extension is also imported.

• set on the Match by record number checkbox and click the Setup... button.
The Match images by numbers window opens.
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Fig. C.9. Images matching by numbers

1. In the Numbers in the file section set the following parameters:

○ Serial numbers of records matching the template – is used to match
a list of records numbers in a file by order;

○ Read from the Name field – is used to match a list of records numbers
in a file by the last number from the filename.

2. In the Numbers of images in the project section set the following paramet-
ers:

○ Serial numbers of images – used to match a list of records numbers in
a project by order;

○ Read from images names – used to match a list of records numbers in
a project by the last number from the filename.

3. Input necessary parameters to the File recordwith the number andmatches
project image with number input fields.

For convenient setup of necessary parameters it is recommended to place windows
in that way that allows to display on screen a name of the first image in the table
of the Exterior orientation parameters window, and also allows to display first
rows in the Preview file table of the Exterior orientation import window. It is re-
commended to place the Match images by numbers window in such a way that
allow to show both windows mentioned above.

5. Choose one of the following formats to specify a type of imported file:

• PAT-B matrix – file containing coordinates of projection centers and rotation
matrices.
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If the PAT-B file contains exterior orientation parameters, calculated for negative plane,
set the Negative checkbox.

In case of data export from the PAT-B matrix, the further line template setup is not re-
quired. Click Next to move to the second step.

• CSV (projection centers, Omega/Phi/Kappa angles and GPS-time) – file
containing coordinates of projection centers in any coordinate system, as well
as exterior orientation parameters, and precise time from GPS-receiver.

Line template by default: Name, X, Y, Z, Omega, Phi, Kappa (see below).

CSV format is exchange text format with *.csv extension, which is supported by major
applications in different industries. It is used as exchange format when special geospatial
data formats are not applicable for some reason.

• CSV (navigation data: latitude/longitude/altitudeWGS-84, heading/pitch/roll
angles and time) – file containing navigation data (latitude/longitude set in de-
grees, altitude in meters, angles in degrees, radians or gons) and precise time
from GPS-receiver.

Line template by default: Name, Lat, Lon, H, Heading, Pitch, Roll.

To perform import of exterior orientation parameters it is necessary that a project is in
coordinate system consistent with WGS-84 coordinate system.

• CSV (navigation data: projection centers in working c.s., heading/pitch/roll
angles and time) – file containing navigation data (coordinates of projection
centers in project coordinate system, angles in degrees, radians or gons) and
precise time from GPS-receiver.

Line template by default: Name, X, Y, Z, Heading, Pitch, Roll.

6. [optional] If data is imported from *.csv format, it is necessary to setup a current
line template.

The Line template field displays the list of main and additional fields, contained in
each line of imported file (depending from selected import format):

• Name – image name;

• X, Y, Z (or Lat, Lat, H) – coordinates of center of optical image projection;

• Omega, Phi, Kappa (or Heading, Pitch, Roll) – Omega, Phi, Kappa angles (or flight
heading, roll and pitch);
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• [optional] STDDEVX, STDDEVY, STDDEVZ – accuracy of linear exterior orientation
parameters (RMS);

• [optional] STDDEVOmega, STDDEVPhi, STDDEVKappa – accuracy of angular exterior
orientation parameters (RMS);

• T – time from GPS device;

• * – fields, that will be missed during import.

The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped.

In order to begin the setup of active template, perform the following:

• [optional] To display necessary number of lines in the Preview file table, set the
Preview maximum parameter. Default number of lines is 10.

• [optional] To specify a line from to start data import, define the value of the Start
import from line parameter.

In many cases, the imported file may have a first row containing headers describing the
contents of the columns in the file. Accordingly, this row should not be included in the
imported data, but its display in the Preview file table may be useful when setting up
the row template. It is recommended to set this parameter at the very end, when pro-
ceeding to the next step.

• In the Field separators section set on one or multiple checkboxes to specify
possible fields delimiter symbol: Comma, Space, Tab, Semicolon or Other de-
limiters. Default settings are comma and space.

• In the Decimal separator section setup the following parameters:

○ Point only – to use point only as a decimal separator in coordinates;

○ Point or comma – to use both point and comma as a decimal separator in
coordinates.

If comma is used as Field separator, it is not recommended to use comma as
Decimal separator, since it may cause import of incorrect data.

• [optional] In the Misc section set the checkbox:
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○ UTF-8 – is used to recognize text in Unicode encoding;

Unicode – symbols encoding format that allows to provide symbols of almost all
written languages.

○ Parse ° ’ “ – is used to recognize records of projection centers or GCP.

When using this parameter it is highly recommended to check points coordinates recog-
nition correctness after import.

Fig. C.10. Setup a file string template for import of exterior orientation parameters (the table is
divided into columns, but their order is not correct)

In order to finish the setup of the active template, perform one of the following ac-
tions:

• drag by mouse field name from theAvailable fields list to the head of the column
of the Preview file table. After that the template in the Line template field
changes. In order to cancel field selection, double click the column of the Preview
file table column;

• change the template manually in the Line template field. At that column types
in the Preview file table are changed automatically.
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To cancel the field name double click the column.

Fig. C.11. Setting up the file line template to import exterior orientation parameters (correct data
entered in the Line template field). The first line of the file that needs to be excluded from import is

highlighted, starting the import from line 2

The button allows to use the default template.

The button is used to compare the Line template field with data shown in the Preview
file table.

The button is used to replace specified field names by field values taken from the first
line of the Line template table.

[optional] The Automatically validate template checkbox is set on by default that
allows to select current template automatically. In order to configure the template
for file containing lines with different columns number, set off the Automatically
validate template checkbox and configure the template in the Line template field
manually.

7. Click the Next button. The Exterior orientation import – Step 2 of 3: Import
settings window opens.
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Fig. C.12. Import options of exterior orientation parameters

Define the following parameters of import:

• In theAngles section specify measurement units for angles coordinates according
to data of the file to be imported:

○ radians;

○ degrees;

○ gons – plane angle measurement unit that equals to 1/100 of flat right angle
measurement unit, and full angle is 400 gons.

• [optional] In order to make correction to kappa angle, set on theAdd to the kappa
angle checkbox and input correction value to the input field.

• [optional] In order to Invert sign for angles Omega, Phi, Kappa (or Heading,
Pitch, Roll), set on corresponding checkboxes.

• [optional] In the Precision (std. dev.) section change precision of a priori RMS
of measurements of projection centers coordinates and exterior orientation angles.

If Projection centers and Exterior orientation angles checkboxes are cleared, the
appropriate data are imported from the file (if the data are available and the import
parameters are correctly configured in the Exterior orientation import – Step 1 of 3:
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File window). Imported data may differ from image to image. If the checkboxes are set,
the values manually specified by a user are used during import (the same for all images).

8. If import of exterior orientation parameters is performed using the Exterior orient-
ation parameters window, then click the Execute button. After that the exterior
orientation parameters are imported to the list of exterior orientation parameters.

If import of exterior orientation parameters is performed using the Orientation ›
Exterior orientation import...menu item or the Import from file button on the
Aerial Triangulation tab of the main toolbar, then click the Next button. The Exter-
ior orientation import – Step 3 of 3: Additional actions window opens.

Fig. C.13. Additional actions after exterior orientation import

Select and set the following checkboxes to perform automatic execution of these
actions just after import of exterior orientation parameters from file:

• Split block into strips by EO data – to split block images into strips using im-
ported exterior orientation parameters (if all images were loaded to a single strip
on a step of project creation);

• Create block layout by EO data – to create block layout considering imported
exterior orientation parameters;

• Adjust block based on imported EO data – to perform block adjustment using
imported exterior orientation parameters;

• Rotate images in block scheme by block layout – to re-create a block scheme
in 2D-window using block layout по накидному монтажу (this checkbox is
available if the Create block layout by EO data is set).

9. Click the Execute button. Exterior orientation parameters obtained after the import
are displayed in the table of the Exterior orientation parameters window.
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10. Click the Apply button in the Exterior orientation parameters window to save
exterior orientation parameters folder in the project.

11. Click OK. The window closes block scheme by exterior orientation automatically
(to build initial block layout).

Fig. C.14. List of exterior orientation parameters

The program provides possibility to create a block scheme by UAS images if angular
exterior orientation parameters of block images are specified with low accuracy or are
unavailable. For this operation it is necessary to use the button of the Exterior ori-
entation parameters window toolbar:

Fig. C.15. The Compute Kappa angle by flight direction window

Specify how to compute Kappa angle by flight direction – for all images of for the
selected images only. For each highlighted image the program calculates the direction
from previous to next center in a strip (for utmost images of a strip – from adjacent image
to the current one) and kappa angle is setup from this direction.
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If the survey time is available the correct images order is checked, otherwise images in strips
should be located in chronological order only.

In order to eliminate blunders in block scheme building by exterior orientation parameters,
perform the following actions:

1. Refine block layout parameters, by performing the following actions:

1. Choose Block › Block layout. The Block layout window opens:

Fig. C.16. The Block layout window

2. Choose the By EO mode and click the Apply button.

See a description of block layout creation in the “Aerial triangulation” User Manual.

2. Import exterior orientation parameters from a file of text format once more and refine
import parameters.

3. To split images into strips by imported exterior orientation parameters (if any), per-
form the following:
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1. Choose Block › Split into strips › By exterior orientation data. The Split
into strips by exterior orientation window opens.

Fig. C.17. Split images into strips by exterior orientation

2. Specify the following parameters of splitting images into strips:

• Images order from by GPS-time or image names;

If the GPS-time is unavailable for part of images, they add to the separate strip
automatically;

• Direction of motion between strips – up to down or bottom up;

• Direction of motion inside strips – left to right or right to left.

3. Click OK. Block scheme rebuilds by set parameters.

Block scheme, created using exterior orientation is an initial block layout and requires
further refining by tie/GC points (see Section C.4.1).

C.4. Relative orientation
This chapter describes the process of automatic creation of tie points using the correlator. For
a detailed description of the relative orientation of images (including a description of creating
and editing tie points manually), see the “Relative orientation” section of the “Aerial triangulation”
User Manual.

One of the stages of building a triangulation network is images relative orientation, that
requires measured coordinates of tie points.

Tie points – the same points on the terrain on adjacent block images needed to build
single models from stereopairs and then to merge them into triangulation networks.
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After measurement of tie point coordinates it is necessary to perform relative orientation
of block images, to input and measure GCP coordinates, to perform network adjustment
and to obtain exterior orientation parameters of a block.

Measuring of tie point coordinates – is stereoscopic measurement, i.e. measuring of
coordinates of the same point on both stereopair images at once (or on multiple over-
lapped adjacent images) in stereomode.

C.4.1. Automatic measurement of tie points coordinates (general in-
formation)

The system provides possibility to measure tie points coordinates and perform relative
orientation in automatic mode. When working in automatic mode correlation algorithm
is used for search and measurement of tie points coordinates.

C.4.1.1. Required data

To perform automatic measurement of tie point coordinates the following data should
be available:

• interior orientation parameters of images, which will be considered in automatic
measurement of points coordinates;

It is highly recommended to perform interior orientation prior to automatic search of tie points,
since otherwise most of the filtering parameters are ignored, that considerably reduces relative
orientation quality.

• block layout (see the “Aerial triangulation” User Manual).

Sufficient condition for launch the operation of automatic measurement of tie points coordinates
is availability of initial (“rough”) block layout, considering, for example, exterior orientation
data (see above) and/or quick ties data, or size of images overlap.

However, the more data is used for the block layout creation, the more accurate is the block
scheme and, hence, the better the results of measurement of tie points coordinates in auto-
matic mode.

C.4.1.2. Modes of automatic measurement of tie points coordinates

The Automatic tie points measurement (Orientation › Automatic tie points meas-
urement) window have different configurations, provided to process various data types:

When working with airborne data the window allows to select manually optimal combin-
ation of basic and additional parameters of automatic ties search, measurement and
filtering, and also to save sets of this parameters as files with *.x-ini extension for the
further usage (see the “Aerial triangulation” User Manual).
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When working with UAS and oblique data the window allows to load parameters sets
for automatic ties search, measurement and filtering (so called “presets”).

Preset – parameters set of automatic tie points measurement, preliminary created by user or
setup in advance.

C.4.1.3. General order of automatic tie points measurement

To measure tie points using automatic mode (на примере airborne data) perform the
following:

1. Create a block layout considering available data.

Parameters of inter-strip stereopairs forming have a significant impact on automatic
tie points measurement and on further adjustment.

You can configure parameters of inter-strip stereopairs forming in the Parameters
window (Service › Settings) on the Block scheme tab, Forming interstrip ste-
reopairs section.

Fig. C.18. The “Forming interstrip stereopairs” section of the “Block scheme” tab of the “Settings”
window

• When specifying theMinimal images overlap for forming interstrip stereopairs
parameter, the user should correctly estimate the interstrip overlap value (in case
of “bad” overlap high values of this parameter will lead to the fact that interstrip
ties will not be measured);

• The Form stereopairs parameters allows to choose, which stereopairs with
specified overlap will be formed – all or with maximum overlap. If the all option
is selected, it allows to considerably increase the number of measured interstrip
points, with significantly increased time costs.

2. Setup parameters of tie points automatic measurement, transfer, filtering and start
the operation of automatic measurement of tie points coordinates;
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3. Perform accuracy estimation of relative orientation and detecting of tie points
measurement errors;

4. Manually eliminate errors of tie points measurement in the Points measurement
module or choose other filtering parameters (for example, specify more “strict” tol-
erances for measurement errors) and start the operation of automatic measurement
of tie points coordinates once more;

5. Update block layout considering tie points. Change settings of automatic tie point
measurement parameters if necessary and start once more operation of further
collecting of tie points measurements. Repeat steps 3-4 until obtain satisfactory
results.

C.4.2. Automatic tie points measurement on UAS data

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › UAS. The Automatic
tie points measurement window opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window (see “General system’s para-
meters” User Manual).

2. Select one of default sets of measurement parameters (presets) or set manually
the new one;

The recommended default preset is Optimal.

3. [optional] set the main parameters for tie points filtering, camera calibration and
block adjustment;

4. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates;

5. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.
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Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce themaximum number of parallel tasks by half in order to ensure
system’s stability.

Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

Fig. C.19. Parameters of distributed measurement of tie points in automatic mode

3. The system allows to clear the task list step by step in the distributed pro-
cessing monitor (tasks are removed from the list as they are successfully
completed).

Clearing the task list makes it possible to limit the increasing size of the distrib-
uted processing database, what can significantly affect system performance.

It is strongly suggested to clear the task list when processing large amounts of
data on workstations with limited disk space.

Full display of the task list (for further analysis of their logs) may be feasible
when restarting calculations, if the previous data processing session failed.

4. Click OK to go back to previous window.

The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-
tributed processing” in the “General information” User Manual).

6. The processing report (see the appropriate chapter in “Aerial triangulation” User
Manual) opens automatically after the operation is completed, if after the completion
of automatic relative orientation the adjustment was carried out (see the Make
block adjustment checkbox below).
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User also can open the relative orientation report to view results of relative orientation op-
eration and to fix measurement errors (see the appropriate chapter in “Aerial triangulation”
User Manual).

C.4.2.1. Main parameters of automatic tie points measurement

The Automatic tie point measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation › Automatic tie point measurement › UAS. The Automatic tie
points measurement window opens.

Fig. C.20. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar;
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The system provides the following buttons in the toolbar to work with auxiliary windows:

○ – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

○ – allows to select triplets without tie points;

○ – allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

When searching for stereopairs and triplets, excluded ( ) points are also not taken into
account. The Excluded status (in this case) is equivalent to no measurements. The user
can change the status of a point using the appropriate tools of the Triangulation points
window.

• a list of project images, intended for the manual selection of the images, scheduled
to perform automatic measuring of tie points coordinates;

• the Correlator configuration section is used to load, create and edit sets of para-
meters of automatic tie points measurement (presets);

• the OK button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

Configure the following parameters of tie points rejection and (optionally) further block
adjustment procedure:

• [optional] clear the Calibrate camera checkbox if camera calibration has already
done and is not needed;

It is recommended to clear the Calibrate camera checkbox only if there is reason to trust
the camera calibration. It is necessary to consider, that if the calibration was not carried out
in actual operating conditions, then significant discrepancies in the obtained calibration
parameters may occur.

If polyplets (sets of several overlapped images located on different strips) are not found, one
of camera calibration stages (calibration by polyplets) will be skipped (an appropriate warning
message will appear). Other calibration stages will be carried out.

In certain cases, since some coefficients can be dependent, it is impossible to calculate cor-
rections to them (during camera calibration, before performing adjustment). In such cases,
some of these coefficients can be automatically excluded from the calibration process (but
not from the adjustment process) i.e. during data processing, the initial coefficient value will
be used, without introducing corrections. An appropriate info message is to be displayed in
the progress bar (see the “Loading progress window” section in the “General information”
User Manual).
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• [optional] clear the Make block adjustment checkbox if the adjustment operation is
not necessary at this stage of the project;

○ [optional] Clear the Tie points rejection by adjustment results checkbox to avoid
rejecting points after preliminary adjustment.

If this checkbox is set, after the project has been pre-adjusted, the process of rejecting
points with rough errors is initiated, followed by a readjustment. It is recommended to keep
this checkbox set.

○ In case of georeference data is unavailable or not enough, the system offers user
to perform adjustment in free model (see the “Adjustment parameters of central
projection images block” and “Adjustment in free model” chapters in “Block adjust-
ment” User Manual).

In this case, the Pixel size (free model) field appears in Automatic tie points
measurement window:

Fig. C.21. The Pixel size (free model) field

If the relevant data is available, the user can input in this field an approximate av-
erage pixel size in the block images. After adjustment, the rotation, scaling, and
shift of projection center coordinates are carried out accounting for the maximum
reduction of the average block pixel size to the specified size.

The approximate average pixel size is set by the user based on available information about
the survey conditions and the parameters of the camera – the focal length and the matrix
size used for the video recording – as well as the average flight altitude of its carrier.

The user-set GSD value is automatically stored up by the system and can be used, after
adjustment, to perform further work.

Adjustment in free model allows to perform control of blunders in tie points measurements.

• [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.
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In case of aerial survey data processing, primary block layout is as usual quite accurate for
imagery provided with correct elements of exterior orientation and taken with off-nadir angle
no more than 15 degrees.

• [optional] in order not to use boundary regions of imagery while search, set theOffset
from image boundaries, % by clicking the button. The Image margin window
opens. Set image margins in percent which are not to be involved in points search;

Fig. C.22. The Image margin window

• To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

The intensity of GPU usage can be monitored using various free software.Windows 10 users
can monitor GPU activity through theWindows Task Manager (Performance Tab).

It is recommended to usemodern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.If there is a choice, first of all, NVidia video ad-
apters are preferable.

During distributed processing, video adapters are to be selected in theMonitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-
sources will be used for distributed computations only if the Use GPU checkbox is set in the
current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).
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C.4.2.2. Correlator configuration

The Correlator configuration section is used to load, create and edit presets – set of
parameters of automatic tie points measurement;

• the download button in the right part of the Correlator configuration section allows
to open the Correlator precision window, which contains a list of available (both
predefined and user-created) presets and the following buttons:

Fig. C.23. The Correlator presets window

○ Create – allows to create a custom preset – set of parameters of automatic tie
points measurement. Click the Create button to open the Enter entry window,
where user should enter a name for a preset to be created (default user preset).

Fig. C.24. The Enter entry window

It is not allowed to create presets with identical names. When you try to create presets
with identical names, the system opens a window with a corresponding error message.

Clicking the OK button opens the Edit parameters window, where you should
manually specify the following parameters:
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Fig. C.25. The Edit parameters window

■ Starting pyramid level – it is recommended to increase the value of starting
pyramid level when system performance is insufficient, and when there is no
high requirements to processing results accuracy. Recommended value of
starting pyramid level is 1. The value of the starting pyramid level that equals to
zero provides maximum accuracy of the results, but leads to increasing of data
processing time;

■ Ending pyramid level – it is recommended to increase the value of ending
pyramid level when using data with different resolution (including cases of signi-
ficant difference in spatial resolution within one image);

For example, when using data which resolution varies 2 times, it is recommended to
increase the default value of the ending level of the pyramid on the one.

■ Maximum vertical parallax (in pixels or mm) – threshold value for rejection
executed after points measuring/transfer. On each step of rejection process, the
program searches for the point with maximal Y-parallax on the stereopair and
rejects it. After that, it makes relative orientation once more and the iteration is
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executed until maximal Y-parallax exceeds the parameter specified here, or until
6 points or less remain on stereopair. Recommended value is a pixel size;

■ Points per stereopair – allows to specify a number of points to be measured
on in-strip and inter-strip stereopairs;

The resulting number of measured points may be both greater than a predetermined
amount – due to points transfer from adjacent stereopairs, and less due to the sub-
sequent rejection of points. Default value is 30 points on each in-strip images pair, and
10 points – in inter-strip overlap. The minimum number of points to control the vertical
parallax residual is 6.

■ Minimal correct matching points in pair, in percent allows to exclude from the
processing “bad” stereopairs that do not match the given values. The increase
of this parameter can improve the system performance by excluding a portion
of data from the processing;

Default value of this parameter is 30%.

When the default value increase, an approximate estimation of the system speed change
is displayed – faster than 30% in ... times.

When the default value decrease, an approximate estimation of the system speed
change is displayed – slower than 30% in ... times.

■ Set the Filter non-transferred points checkbox on to reject points located on
inter-strip stereopairs. A point will be filtered, if the system recognizes it on a
single image of some strip.

Set the image pair selection method:

■ [optional] by block scheme;

The Low block layout quality checkbox allows to divide the process of stereopair
search by block scheme into several iterations, thereby increasing the accuracy of final
results.

If there is one or more image with no metadata in the project, use the Complete enu-
meration for images with no projection centers checkbox to search for stereopairs
for such images not only among the closest images in a block but among all the project
images.

■ [optional] by image centers – set the number of neighbour images andmin-
imum distance between centers in stereopair.
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In case of the processing of quite high-quality data with satisfactory overlap, limiting
the number of adjacent images leads to a significant increase of data processing speed,
without affecting the accuracy of the final results.

Limiting the minimum distance between two centers in a stereopair allows to exclude
from processing stereopairs with projection centers that are too close to each other.

When you click OK, the system creates a new user preset – a set of parameters
used for automatic tie points measurement.

○ the Edit button allows to open the Edit parameters window to change settings of
the selected preset.

○ the Copy button allows to copy a preset.

○ the Rename button allows to rename a preset.

○ the Delete button allows to delete a preset.

○ the Close button allows to close the Correlator precision window.

• The arrow to the left of the button which opens the Correlator precision window al-
lows to open a drop-down list, used to select one of the following presets.

The system provides a set of predefined presets, allowing to vary the settings of
automatic tie point measurements. Predefined presets are marked by the asterisk
symbol *.

The system does not allow the user to edit the predefined presets. A copy of the predefined
preset is available for editing, as well as a custom preset.

C.5. Ground control points
This chapter addresses importing a GCP catalogue from a text file and manually measuring
GCPs in images. For detailed information on GCPs (including manually entering geodetic co-
ordinates of points and automatically measuring GCPs in images), see the “Aerial triangulation”
User Manual.

GC point is a terrain point with known geodetic coordinates, which is a source point for
photogrammetric measurements.

Measurement of GC point coordinates means adding of known terrain point coordinates
to GC points list and measurement of its pixel coordinates on image. In order to use
GC points during block adjustment perform the following actions:

1. Import coordinates of GCP to coordinates list.

2. Measure coordinates of GC points on project images.
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To perform correct block adjustment it is recommended to measure coordinates of all input
GC points on block images, since all points – both measured and unmeasured – take part
in statistics during block adjustment. Otherwise, it is possible to exclude unmeasured points
on steps of coordinates measurement and block adjustment.

Adding and measurement of GC points coordinates on block images in the system allow
to calculate exterior orientation parameters of images block, when metadata with exter-
ior orientation parameters, obtained from a provider, is not available.

If the GC points coordinates data is unavailable at the time of data collection for aerial
triangulation procedure, the system provides possibility to adjust a block in a free
model (without GC points), that allows to proceed to project processing step directly
(see the “Block adjustment” User Manual).

When deleting images from a project it is highly recommended to synchronize data in a project
to remove redundant results of orientation. To do this choose Project › Synchronize.

C.5.1. Import of GCP catalogue

The system provides import of GC points coordinates list from file with *.csv or *.txt
extension.

Refer to the “Import of triangulation points from X-points” chapter of the “Aerial triangulation”
User Manual for the description of the GC points import from file with *.x-points extension.

To perform import of GC points coordinates list from file perform the following actions:

1. Click the Import catalog button on the Aerial Triangulation tab of the main
toolbar.

2. Select a file containing GCP catalogue and click OK. The Import GCP catalogue
window opens.

84

Processing of UAS data (Windows x64)PHOTOMOD 8.1

solver.pdf
measurement.pdf


Fig. C.26. Import of GCP catalogue

3. Make sure that the Line template was configured correctly.

The Line template field displays a list of main and additional fields, which must be
located in each line of the import file:
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• Name – object’s name;

If imported file does not contain a column with GCP names (numbers), then after import
operation the names like Point0001 are assigned to the points automatically.

• X, Y, Z – values of GC point coordinates by X, Y, Z axes;

• [optional] STDDEVX, STDDEVY, STDDEVZ – accuracy of coordinates measurements
by X, Y, Z axes (RMS;

• [optional] * – marks columns with data which is not imported.

The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped. To all vertexes two (for 2D objects import)
or three coordinates are specified.

In order to begin the active template setup, perform the following:

• [optional] In order to display necessary number of lines in the Preview file table,
set the Preview maximum parameter. 10 lines are displayed by default.

• [optional] In order to define a line from which to start data import, input the line
number to the Start import from line field.

In many cases, the imported file may have a first row containing headers describing the
contents of the columns in the file. Accordingly, this row should not be included in the
imported data, but its display in the Preview file table may be useful when setting up
the row template. It is recommended to set this parameter at the very end.

• In the Field separators section set single or multiple checkboxes to specify field
separators in the file: comma, space, tab, semicolon or other. The comma and
space are set by default.

• In the Decimal separator section set the following parameters:

○ Point only – to use only a point as a decimal separator in coordinates;

○ Point or comma – to use both a point and a comma as a decimal separator
in coordinates.
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If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be
created after import operation.

• [optional] In the Misc section set the following checkboxes:

○ UTF-8 – is used to recognize text in Unicode coding;

○ Parse degrees minutes seconds – is used to recognize records from the list
of projection centers or GCP.

When using this parameter it is highly recommended to check recognizing correctness
after import operation.

In order to finish the active template setup, perform one of the following actions:

• drag a field name from the Available fields list to the Preview file table column
header. After that the template in the Line template field is changed. To cancel
a field selection, double click the Preview file table column;

• change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

The button is used to return to default template Name, X, Y, Z.

The button is used to compare the Line template field with data shown in the Preview
file table.

The button is used to replace specified fields names with fields names from the first line
of the Preview file table. It is possible to specify any names for vectors import.

For import of laser scanning data the field names from the list of available names are
specified.
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Fig. C.27. Setup of a template sample

For automatic selection of current template the Automatically validate template
checkbox is set by default. In order to setup a template for a file that contains lines
with different number of columns, clear the Automatically validate template
checkbox and setup the template manually in the Line template field.

4. In the Points with existing names section specify actions to perform when names
of imported GC points coincide with points names already existing on the GCP list
tab:

• Replace – allows to replace a point with the same name in the list, i.e. the point
data will be updated;

• Skip – allows to cancel import of GCP with the same name.

5. [optional] To prevent creating text attributes without value during import, set the Do
not create empty text attributes checkbox on.

When the Do not create empty text attributes checkbox is on, in some cases a data loss
may occur.

6. [optional] To convert coordinate system set the Convert coordinate system
checkbox and specify source and output coordinate systems.
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7. Click OK. The Import ground control points window opens, which contains the
GCP table to be added. Points which names are the same as names of existing
GCP in the GCP list of the Triangulation points window are shown by red color,
new GCP – by black color.

Fig. C.28. Selecting GCP to be added to the list

8. Select points to be imported using checkboxes and/or standard selection tools.
Click OK. After that coordinates of GC points with set checkboxes will be loaded in
the end of the GCP list.

If in the Points with existing names section the Skip parameter is selected, then only
new GCP are selected for adding by default, if the Replace parameter is selected, all GCP
checkboxes are selected to be added.

If RMS of X, Y, Z coordinates was not imported or is absent in GCP file, then default value
of RMS for all coordinates is 0.2 meters.

C.5.2. Measurement of GCP coordinates

Refer to the “Measurement of GCP coordinates” chapter of the “Aerial triangulation” User
Manual for the detailed description.

After completing of GCP coordinates input it is possible to measure these GCP on block
images in the Points measurement module.

In order to measure GC point coordinates perform the following actions:

1. Open the Triangulation points window on the GCP list tab.
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2. Select GC point in the table to measure its coordinates on images and click the
button or double click the point name in the table. The Points measurementmodule
is opened.

If at least three GCPwere already measured on block images or there was executed
preliminary orientation in geodetic coordinate system (by projection centers, for in-
stance), the system performs automatic search for corresponding terrain point on
block images (according to XY coordinates) and places marker on this image point.

When the system performs a search for terrain point in mode of images automatic selection
(the button of the Triangulation points window is clicked) it automatically opens all
images that contain the terrain point with measurements or without them, otherwise – only
images that contain measurements of selected point.

3. Measure coordinates of GC point on a single or multiple images (the point lies in
the overlap area) using one of the following ways:

• GCP coordinates measurement without correlator is used if a point is located on
terrain and is clearly recognized on all images.

Show by marker the terrain point on images. Click the button of the upper
toolbar of the module.

• GCP coordinates measurement and transfer with correlator is used if a point is
not clearly recognized on all images.

In this case measure the point on a single image using the button of the upper
toolbar of the image window or use the Ins hotkey. Define the image as the left
using the button in the image window. Then transfer the point from the left
image to other images using the button to transfer the point on the image in
the active window or use the button to transfer the point on all images opened
in the module.

Recommended correlation coefficient during GCP transfer is 0.90–0.95.

• measurement of coordinates in stereomode is used when the point is located
on high-rised object and/or is not displayed on all images.

4. After measurement of GCP coordinates an information about the measurement
appears in the Tie points list.

To move a GCP on images (to edit measurement of selected point) perform the following
actions:
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1. Select measured GC point in the table of the Triangulation points module and
click the button or double click the point name in the table to display the meas-
urements of selected point on block images.

2. Show by marker new position for selected GC point.

3. Click the of the module upper toolbar. After that the GC point on images is moved
to marker’s position, and measurements data is refreshed in the Triangulation
points table.

To delete the ground control point measurements from the image, select the point in
the Triangulation points table and click the button of the image window in the
Points measurement module.

To delete the ground control point measurements from all images, perform one of the
following actions:

• select a point in the Triangulation points table and click the button on the upper
toolbar on the Points measurement module;

• select a point in the Triangulation points table and click the button on the toolbar
of the Triangulation points window. The Delete points window opens. Click the
Delete point measurements only button.

The operation does not lead to deletion of GC point coordinates from the Triangulation
points table.

To delete a ground control point completely (both the point measurements on the images
and the point with the coordinates from the table), select the point in the table and click
the button of the toolbar of the Triangulation points window. The Delete points
window opens. Click the Delete points from catalogue button.

C.6. Adjustment
Refer to the “Block adjustment” User Manual for the detailed description about block adjustment
procedure.

C.6.1. Preliminary block adjustment

In order to adjust images block perform the following actions:

1. Click the button of Block editor window’s toolbar to refresh initial block scheme
(to refine block layout) using measured tie and GC points:
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Fig. C.29. The Block layout window

See a description of block layout creation in the “Aerial triangulation” User Manual.

2. Choose Orientation › Block adjustment or click the Block adjustment button
on theAerial Triangulation tab of the main toolbar. The adjustment toolbar opens.

See detailed description of interior orientation step in the “Aerial triangulation” User
Manual.

3. Click the button Settings on the Adjustment toolbar. The Settings window
opens.
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Fig. C.30. Adjustment parameters for the first adjustment operation

4. On the Adjustment tab define the following parameters for the first start of the ad-
justment procedure:

1. Choose the by block scheme option in the Approximation computing
method section.

2. Click the Initial approximation parameters button. The Initial approximation
parameters window opens:
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Fig. C.31. The Initial approximation parameters window

3. Set theUse ground control points coordinates andUse projection centers
coordinates checkboxes.

4. Click OK.

5. Choose the bundle adjustment option in the Adjustment method section.

6. Click theAdjustment parameters button. TheBundle adjustment parameters
window opens:

Fig. C.32. The Initial approximation parameters window

7. Set theUse ground control points coordinates andUse projection centers
coordinates checkboxes.
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8. [optional] To take the rolling shutter effect into account when adjusting a project,
set theRolling shutter checkbox and click theCameras button. TheCameras
window opens:

Fig. C.33. The Cameras window

Select cameras whose technical characteristics require rolling shutter compens-
ation when adjusting a project that contains images taken with those cameras.
Click Ok.

Click the button to select all cameras in the project. Click the button to deselect
all cameras.

The effect of rolling shutter is the distortion of object shapes in an image when a picture
is not captured at the same instant but the image is captured progressively. This effect
appears at the short shutter speed of focal plane shutters or interline transfer CCD.

Survey data containing such distortions can be obtained using cameras installed
aboard some UAS. It is recommended to use rolling shutter compensation algorithms
if appropriate information about the properties of the equipment used is available.

9. Click OK to return for the Parameters window.

5. Click Compute to start the adjustment operation.

6. To analyse the adjustment results you can use adjustment report, visual control of
residuals on block scheme and theResidualswindowwhich contains brief residuals
report.

7. Pick out adjustment parameters, analyse and eliminate residuals to obtain satisfying
adjustment result.

After making any alterations to points measurements data it is necessary to re-start the
adjustment procedure once again.

At subsequent start of the adjustment, the results of previous adjustment processes are
used by default (the Use current solution checkbox on the Adjustment tab of the Para-
meters window).
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The system allows to perform re-adjustment by changing any settings of bundle adjustment
(in this case it is not recommended to clear the Use current solution checkbox, since that
can lead to poor adjustment results).

8. It is recommended to use self-calibration of camera parameters during adjustment
procedure, if camera without calibration was used.

C.6.1.1. Adjustment procedure

In order to perform adjustment, it is necessary to setup parameters of project adjustment
and click the Compute button. The calculation procedure is started and the window
opens where the adjustment operation status is displayed.

Fig. C.34. Window of adjustment procedure status

Adjustment operation convergence is represented by the diagram. The window also
shows iteration number, adjustment method, and a value of refinement.

If the iterative process does not converge, interrupt the adjustment operation using the
Stop button to display a result obtained on current iteration. In order to delete all the
adjustment results click the Cancel button.

Non-convergent adjustment may be caused by relative orientation errors, errors in GCP coordin-
ates or by incorrect adjustment parameters (see the “Stages of accuracy control” chapter in
“Block adjustment” User Manual), or due to wrongly defined coordinate system (right-left).
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Adjustment procedure interrupts only between iterations, at that the adjustment results are
saved.

In order to save satisfactory adjustment results click the button of the Block adjust-
ment toolbar. Pass to further project processing.

The button on the Adjustment toolbar is used to restore current block status. Also
it allows to load adjustment results after project loading.

When adjustment brings unsatisfactory results and it is necessary to bring the block
back to its initial status (as it was prior to adjustment launch), click the button on the
Adjustment toolbar.

C.6.2. Using self-calibration

[optional] If a complete set of camera parameters is unavailable, use self-calibration of
camera parameters during adjustment procedure.

Self-calibration of camera parameters – is automatic calculation of camera parameters (correc-
tions to principal point coordinates and focal length, distortion coefficients) during adjustment
operation.

In PHOTOMOD UAS system self-calibration of camera parameters option is set on by default.

To use self-calibration of camera parameters during adjustment operation perform the
following actions:

1. Make sure that the Perform self-calibration checkbox on the Adjustment tab of
the Parameterswindow is set on and click the Self-calibration parameters button.
The Camera parameters self-calibration window opens.

See detailed description of self-calibration operation in the “Block adjustment” User
Manual.

2. Choose camera to be calibrated in the Cameras table.

3. Select the Calibration type: Physical or Mixed.

For self-calibration of a camera having a focal plane shutter, it is recommended to use
Mixed self-calibration.

4. In the Coefficients table define initial values of camera parameters in the Initial
value column and choose parameters for optimization in the Optimize column.
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Fig. C.35. Self-calibration of camera parameters

5. Click OK. Setup adjustment parameters in the Parameters window and click the
Compute button to start the adjustment procedure.

6. When the adjustment procedure is completed estimate the adjustment accuracy
and results of camera self-calibration shown in the Adjustment column of the
Camera parameters self-calibration window. If you are satisfied with the results
pass to step # 5, otherwise, change initial values of parameters and/or set of para-
meters for optimization and adjust the block once more.

7. Click the Save button to save the adjustment results.
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8. Choose Orientation › Manage cameras. The Manage project cameras window
opens.

9. In the Project cameras list select new calibrated camera (cameras) <...>[selfc-
al].x-cam and assign it (them) to project images. Click the Execute button. Click
OK.

See a description of the Manage project cameras window in the “Aerial triangulation”
User Manual.

10. Choose Orientation › Additional › Calculate interior orientation.

11. Choose Orientation › Block adjustment or click the Block adjustment button
on the Aerial Triangulation tab of the main toolbar. Click the button Settings
on theAdjustment toolbar. Block will be adjusted considering new results of interior
orientation.

C.6.3. Brief residuals report

The program allows to display brief residuals report, which contains RMS errors, mean
absolute and maximal adjustment errors.

Brief residuals report is used for quick estimation of adjustment results without viewing
detailed report.

In order to display brief residuals report, click the button on the Adjustment toolbar.
The Residuals window opens.
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Fig. C.36. The Residuals window

In the Stereopairs mode brief report contains information about mean absolute errors
on GCP and check points (in meters), about tie and targeted points, as well as about
tie residuals on projection centers (mutual and from mean residuals).

If adjustment is performed by bundle adjustment procedure, the Sigma_0 value is calculated.

The Sigma_0 value shows howmuch adjustment discrepancies correspond to specified thresholds
on points coordinates measurements and input GCP data (GCP and projection centers coordin-
ates). If the thresholds were specified correctly, the Sigma_0 has value close to 1 (±30%).

If the Sigma_0 is much greater than 1, there are errors in points coordinates measurements, in
input GCP data or because of incorrectly specified thresholds on points coordinates measure-
ments. If the Sigma_0 is mush less than 1, the threshold on points coordinates measurements
were specified incorrectly or there are some other errors (see Section C.6.4).

C.6.4. Creating adjustment report

The program provides possibility to view full statistics of adjustment, summary information
about adjustment residuals and control data.
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To display adjustment report click the button on the Block adjustment toolbar and
set the needed Parameters in appropriate window (see the “Block adjustment” User
Manual).

Fig. C.37. The window of adjustment report

The toolbox of the Report window contains the following buttons:
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• – allows to return to previous view of the report;

• – allows to refresh the report;

• – allows to start search in report’s text (Ctrl+F);

• – allows to save a report into text file;

The report also saves in the \backup project folder automatically with the adjustment results
(only for central projection images).

• – allows to save a report into system resources;

• – allows to print a report.

The adjustment report displays the following values:

• residual values calculated on GCP, check, tie points, and projection centers for the
whole block and for each point;

• catalogue of points coordinates;

• images exterior orientation parameters;

• GPS corrections;

• corrections for exterior orientation parameters.

Report content is setup on the Report tab of the Parameters window.

Residuals and errors are displayed in the report as follows:

• X, Y, Z – coordinates values taken from model (from strip when using independent
strips method, from stereopair when using independent stereopairs method);

• X1, X2, Y1, Y2, Z1, Z2 – values of points coordinates on two different models;

• Xср, Yср, Zср – values of points coordinates, averaged over all models;

• Xg, Yg, Zg – geodetic value of points coordinates, specified by the user for GCP and
check points;

• Exy, Ez – average residuals of points XY and Z coordinates;

• dX, dY, dZ, dS – discrepancies on GCP;

• dX, dY, dZ, dXY – GPS corrections on projection centers.
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C.6.5. Correcting errors in the positions of triangulation points

Block adjustment accuracy control includes checking the magnitude of errors in determ-
ining XY- and Z-coordinates of triangulation points. For ground control and tie points,
XY- and Z-coordinate errors are displayed visually as various error vectors, and the
numerical values of the errors are displayed in the adjustment report. Block adjustment
accuracy control includes checking the magnitude of errors in determining XY- and Z-
coordinates of triangulation points.

Fig. C.38. The triangulation points and residuals vectors

The triangulation points and residuals vectors displaying parameters are described in “Setup
of points symbols” and “Parameters of points and error display on a block scheme” chapters in
“Block adjustment” User Manual.

The causes of rough errors, as a rule, can be incorrectly specified (or, in rare cases,
initially incorrect) coordinates of ground control points, as well as errors in the positioning
of tie and GC points in the images. It is possible to improve unsatisfactory adjustment
results, which can be partly caused by the errors described above, by editing the trian-
gulation points and readjusting the project:

• For tie points:

○ Deleting a tie point from the project;

○ Assigning the tie point the Excluded type – to exclude a point from the adjustment
process without deleting it from the project;

○ Correcting the point’s position in images (see below).
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• For GCPs:

○ Deleting a GCP from the project;

○ Assigning the GCP the Excluded or Check point type.

The Check points is not involved into block adjustment (as a GC point), but is used as a
tie point. It is also can be used for the further accuracy control. The Excluded points type
is used for temporal point exclusion fromGC points list, for example, to exclude unmeasured
GC points prior to block adjustment.

○ Correcting the position of the GCP in the images (for example, the GCP was incor-
rectly measured in the images due to an insufficiently detailed outline);

○ Correcting entered geodetic coordinates of the GCP (for example, the operator
made an error when entering the coordinates of the point).

In order to change point’s type or position perform the actions described below (see also full
description in “The “Point attributes” window” chapter of “Block adjustment” User Manual).

Click the button on the Block adjustment toolbar to complete changing point’s position on
image.

In order to change triangulation points position on images perform the following actions:

1. On a block scheme or in a list of points select a point (or several points), which re-
sidual exceeds specified threshold value (the residuals vectors are shown by red
color).

Acceptable residuals are set in the appropriate section of the Report tab of the adjustment
parameters window (see the “Block adjustment” User Manual).

2. In the Points attributes window click the Measure button. The Points meas-
urement window opens (with images on which the selected points are located).

For details see the “The “Points measurement” module” chapter in the “Aerial triangulation”
User Manual.

The list with in only selected points is displayed in the Triangulation pointswindow.
Only these are also displayed on images.

Tie and ground control points are distributed into the corresponding tabs of the Triangula-
tion points window ( , ).

By default the filter is applied on both Triangulation pointswindow tabs (display
points selected on the adjustment stage). The following buttons on a toolbar of the
Triangulation pointswindow (in Tie points tab) allows to change the filter for points
list, that are displayed in the table and on images:
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• – all points;

• – points on open images;

• – common points on open images.

3. [optional] In order to display GCP residuals vectors ( ) and/or tie residuals vectors
( ) click the appropriate buttons in leftward toolbar of the Points measurement
window;

4. Move a point manually or using correlator (see description of correlator work in the
“Aerial triangulation” User Manual). Each image window in the module contains the
following buttons of upper toolbox used to work with image:

• – allows to move or add selected tie or GC point to marker’s position;

• – allows to move a point along tie residual vector;

• – allows to move a point along GCP residual vector;

• – allows to remove measurement results for point selected on image;

Fig. C.39. Editing tie point location. Tie residuals vector (on the central image) is colored blue

5. Click OK to exit the Points measurement module.

6. Click the button on the Block adjustment toolbar to complete changing point’s
position on image.
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In order to use interstrip points and points non-transferred in some strip in the adjustment by
independent strips method or independent stereopairs method, it is necessary to measure co-
ordinates of the points on adjacent images inside the strip during aerial triangulation or in the
Points measurement window (see the “Aerial triangulation” User Manual).

In order to change geodetic coordinates of points on image perform the following actions:

1. On a block scheme or in a list of points select a GC point;

2. In the Points attributeswindow click theCoordinates button.The Triangulation
pointswindow opens (onGCP list tab). In this window the information about selec-
ted GCP is displayed.

Double-click of points string allows to open the Points Measurement window and change
point’s position (see above).

3. Select the GC point in Triangulation points window table by left mouse button
click. Click the button in Triangulation points toolbar. The window Point
properties opens:

Fig. C.40. Point properties

For GC points the geodetic Coordinates and RMS of point are displayed. Specify
the needed parameters and click OK to close the window.

C.7. DTM building
Refer to the “DTM Generation” User Manual for the detailed information about generation of
digital elevation model (DEM).
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Digital Elevation Model (DEM) – digital cartographic presentation of terrain surface both
as regular grid of elevations (DEM) and as triangulated irregular network (TIN).

The following data sets (individually or in combination) are used for generation of digital
terrain model:

• Points – point vector objects, located on relief surface;

• Triangulation Irregular Network (TIN) – one of the models of spatially coordinated
data, used during designing of digital terrain model as elevation points in nodes of
irregular network of triangles, that corresponds to Delaunay triangulation;

• Contour lines – vector lines, that connect points with the same terrain altitude;

• Digital elevation model – digital cartographic presentation of terrain surface as regular
grid of elevation values.

The Terrain menu is used for working with the above mentioned data sets. Key com-
mands are placed in the DTM building tab of the program’s main toolbar.

C.7.1. The preparation steps

C.7.1.1. Grid creation

The program provides possibility of regular grid creation with specified step. A grid step
is used as a frequency of nodes creation, in which vicinity spatial coordinates are cal-
culated and points are created.

The grid could be created both for the whole images block and for any part of a block
or for selected stereopair. A shape of grid borders could be rectangular or as arbitrary
polygon (or several polygons).

To create a grid select Grid › Create (Ctrl+N, G) or click the button of the main
toolbar. After that a new layer Grid is created in the Layer Manager.

Area of grid creation is determined in one of the following ways:

• in order to create a grid with specified rectangular border, press and hold the Shift
key, and drag by mouse a rectangular area over images block or over selected ste-
reopair;

• in order to create a grid with arbitrary border, define a grid creation area in group
selection mode ( ) by polygon and while holding pressed the Shift key, specify by
mouse all nodes of boundary of a grid creation area. Complete creation of arbitrary
grid border by mouse double click.

• to use vector layer polygons as areas of grid creation, perform the following actions:
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1. Select Vectors › Create layer to create vector layer without classifier or load
layer with polygons which could be used as a grid boundaries.

2. Create a polygon in such a way that its boundary coincides with boundaries of
area which is used for grid creation.

3. [optional] Select polygons to be used as boundaries for a grid creation, otherwise,
a grid will be created considering all polygons of the layer.

4. SelectGrid › Create boundaries from vectors. After that created grid boundary
coincides with outline of created polygon.

• to create a grid for the whole images block without defining its boundaries, select
Grid › Properties, specify its parameters and click OK. Grid is created automatically
for the entire block and the grid boundary passes over external boundary of block
images.

When a grid boundary is defined the system creates a grid of nodes with specified or
default parameters.

Fig. C.41. Rectangular grid for the whole images block
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In order to change parameters of created grid, select Grid › Properties. The Grid
properties window opens.

Fig. C.42. Regular grid parameters

The Grid properties window allows to setup the following parameters:

• X step and Y step – steps for nodes creation correspondingly by X and Y axes in
meters;

• Rotation – angle of nodes grid rotation in degrees;

Should be specified for manual work in the pathway mode.

At that, the nodes grid only is rotated. Area of nodes grid creation remains in initial position.

• Z level – a grid elevation above relief level (in meters) for visual correct display of
the grid;

• Ground sample distance (GSD) – shows a value of average pixel size in meters, if
a project contains adjustment results or pixel size is specified for at least one image.

To display a grid with specified parameters click theApply button. To change parameters
click OK.

C.7.2. Compute points

This section discusses the construction of points in automatic mode (including the distributed
processing mode) as well as the filtering of points that are not located on the terrain (average
smoothed surface). For a detailed description of working with points, see the “Points” section
of the “DTM Generation” User Manual.

Points – point vector objects, located on relief surface. Points like other vector layers
are used as a base layer for TIN generation.
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C.7.2.1. Automatic calculating of points

The system provides possibility to calculate points automatically using correlator in
overlap areas of stereopair images by regular nodes grid.

Because of large processing data volumes in UAS projects, it is recommended to use
automatic calculating of points.

All selected stereopairs should be located to adjusted part of a block (see “Block adjustment”
User Manual), otherwise, points calculation is not performed or is performed incorrectly. In the
first case the system displays error message, in the second one – it is not possible to match
calculated points to project coordinate system.

Acquired points are used as a vector base for DEM generation. Additional possibilities
of points editing allow to obtain vector base for TIN creation and DEM generation.

The principle of automatic points calculation is as follows. For each selected oriented stereopair
the system performs automatic pass of all grid nodes, located in overlap area of stereopair im-
ages, and tries to calculate spatial coordinates in vicinity of each grid node using correlator.

In case of successful correlation the system performs accuracy control of each found point’s
coordinates, and after that the point is either added to vector layer as point object, or is excluded
(see Accuracy control with reverse stereopair checkbox). If the system fails to calculate
spatial coordinates in vicinity of some grid node, the node is skipped and the system passes to
the next node.

Fig. C.43. Automatic points calculation in arbitrary area

Prior to start of automatic points calculation perform the following preparatory actions:
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1. Define search area: select block stereopairs where to perform automatic points
calculation.

2. Create regular nodes grid for selected search area.

3. Select Terrain › Points › Compute points automatically or click the Compute
points button on the Compute DEM tab of the main toolbar. The Compute points
window opens.

If a grid not was not created, it is created automatically for the entire images block and the
Grid properties window opens, that allows to specify grid parameters.

Fig. C.44. The Compute points window

4. In theCorrelator preset section select in the list one of the following types of terrain:
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• mountainous terrain;

• urban area;

• desert;

• rural area;

• rural area 2.

To view and edit parameters values and to setup correlator configuration the list, to create
new or delete configurations from the list click the button (see the “Correlator configur-
ations”, “Setup of correlator configuration”, “Additional correlator’s parameters” and “Para-
meters of first approximation calculation” chapters in the “General information about system”
User Manual).

5. In the Search area section specify a search area, which will be used for automatic
points calculation:

• All images – allows to select all images of a block;

• Selected images – allows to select block images highlighted in 2D-window;

To view and change a set of highlighted images in block 2D-window click the button.

• Active stereopair – allows to select images of a stereopair opened in active 2D-
window.

All selected stereopairs should be located on adjusted part of a block (see “Block adjust-
ment” User Manual), otherwise, points calculation is not performed or is performed in-
correctly. In the first case the system displays error message, in the second one – it is
not possible to match calculated points to project coordinate system.

6. [optional] To pass each grid node only once during calculation, prior to define
parameters it is necessary to create pre-regions, set theUse pre-regions checkbox
on and select pre-regions layers in the list (see the “Creation pre-regions for a block”
chapter in “DTM Generation” User Manual).

Binding of pre-regions and stereopairs is performed using region_image_code and region_im-
age_code_2 attributes.

7. [optional] Points calculation is performed by default for in-strip stereopairs. To cal-
culate points for interstrip stereopairs, formed by selected images set the Process
interstrip stereopairs checkbox on.
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8. [optional] To filter blunders by Z on images with intersection angle of small or null
value, set the Limit intersection angle checkbox on and define a value of minimal
angle using the slider.

The system allows to estimate the intersection angles in the stereopairs of the project (see
the “The list of stereopairs for a selected image” chapter in “Creating project” User Manual
and the “Creation of “stereo quality” map” chapter in “Vectorization” User Manual).

9. [optional] In the Grid section the Area of the grid layer in m2, as well as Appr.
nodes count in a grid are displayed in appropriate fields. To change a grid layer
parameters click the Properties button.

To change grid boundaries it is necessary to close the Compute points window.

10. In the Initial approximation the method of calculation of the elevation range of
points with the search for the correlator:

Initial approximation defines a value of Z coordinate of grid node, that is used to calculate
initial coordinates of point on the left and right images of a stereopair.

Selection of the most preferable method to calculate elevation range for point search de-
pends on available data on the terrain (degree of terrain roughness, character of a region
of search where automatic calculation of points takes place).

• Stereopair elevation range – the elevation range is calculated for each stereopair
with heights of points, previously measured in the project;

• Project elevation range – the elevation range is obtained from the Relief elev-
ation values in project properties or it is calculated with heights of points, previ-
ously measured in the project;

• Mean stereopair elevation –mean elevation of each stereopair, calculated using
exterior orientation parameters, is used as initial approximation;

• Fixed elevation – input elevation value in meters to be used as initial approxim-
ation;

• Triangulation points – allows to calculate the elevation range for each stereopair
from a smooth model built by project triangulation points;

• DEM – a value of elevation of selected DEM in point with XY coordinates of grid
node is used as initial approximation.

If grid node falls into null cell of DEM, the system uses average elevation of cor-
responding stereopair. To select DEM in active profile resources click the
button.

113

Processing of UAS data (Windows x64)PHOTOMOD 8.1

project.pdf
vectorization.pdf


To specify value of acceptable deviation of Z-coordinate of calculated points from
initial approximation and input value in meters to the Maximal shift field.

11. [optional] There are the following options in the Additional settings section:

• Save quality assessment to attributes – allows to save quality assessment of
points calculation as attributes of point vector object. Quality assessments are
saved to the following object attributes:

○ ’corr’ (double) – correlation coefficient, number in range from specified correl-
ation threshold up to 1;

○ ’aq’ (double) – auto-correlation sigma;

○ ’std_dev’ (double) – standard deviation;

○ ’pass’ (int) – number of passes;

○ ’disp’ (int) – dispersion value.

To view values of attributes of points calculation quality select the point and
chooseWindow › Object attributes. The Object attributes window opens.

Fig. C.45. Quality assessments of calculated point

• Delete redundant points – allows to thin nearest points, acquired during passing
the same grid nodes on different stereopairs;

Thinning is performed after completion of points calculation operation according to
specified radius value, set by used correlator configuration.

When the Save quality assessment to attributes checkbox is on, points with minimal
correlation coefficient (minimal value of ’corr’ attribute) are removed from several found
nearest points.
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• Random points distribution – allows distribute points randomly in area of half-
size of grid cell from grid node;

• Accuracy control with reverse stereopair – allows to check results of found
point on a reverse stereopair; if results do not the same, point removes;

12. In the Destination section define parameters of loading and saving of calculated
points:

• Load into vector layer – allows to load points into active vector layer;

If there is no active vector layer, points are loaded to a new vector layer.

• Save into resources – allows to save points into active profile resources without
loading. Click the Settings button to specify parameters of points saving. The
Settings for saving points window opens.

Fig. C.46. The Settings for saving points window

To save points in one vector file of active profile perform the following actions:

1. Select the Save into one resource option and click the button. The
Save window opens.

2. Select a folder in the active profile resources and input a name of vector file
in theResource name field. Click OK to create a new vector file and to return
to the Settings for saving points window.

3. The input field of the Settings for saving points window shows path and
name of new vector file. Click OK to return to the Compute points window.

To save points in parts into several vector files of active profile perform the follow-
ing actions:
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1. Choose the Split into parts option.

2. Select one of the ways of points splitting – By rectangular sheets and input
a size of rectangular area in meters or By stereopairs.

3. Input path to save file to the Save in folder field or click the button, to
select name and path in active profile resources to save points in parts to
corresponding vector files and click OK.

4. The input field of the Settings for saving points window shows path and
name of new vector file. Click OK to return to the Compute points window.

13. Click OK. The points calculation operation starts.

In some cases operation of automatic points calculation takes a lot of time.

To setup points calculation in distributed mode click the Distributed processing
button and specify parameters of tasks distribution.

C.7.2.2. Points calculation in distributed processing mode

To calculate points in distributed processing mode, perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Distributed
processing” chapter in the “General information about system” User Manual).

2. Select Terrain › Points › Compute points automatically or click the Compute
points button on the Compute DEM tab of the main toolbar. The Compute points
window opens.

If a grid not was not created, it is created automatically for the entire images block and the
Grid properties window opens, that allows to specify grid parameters.

3. Setup parameters of automatic points calculation.

4. Click the Distributed processing button. The Compute points Distributed Pro-
cessing window opens.
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Fig. C.47. Parameters of distributed processing of points calculation

5. In the Split into tasks section select a way of splitting of processing operation into
tasks:

• By stereopairs – allows to process each stereopair in a separate task;

Since tasks are executed independently from each other, the system doesn’t remove
points, falling into the same grid nodes from different stereopairs (for example, during
filtering of nearest points).

• By rectangular sheets – it is necessary to specify in the fields a size of rect-
angles, into which the entire search area is split (in meters). Filtering of nearest
points is not performed in this case. The result of each task processing is saved
to the file with name like Sheet_X_Y.x-data.

Rectangle, circumscribing grid boundaries in project coordinates system, is split by
rectangular sheets of a size specified in the fields. Each sheet includes images parts
from all stereopairs, into which it falls.

If stereopairs are processed in separate tasks, after that it is necessary to perform manual
data correction. Calculated points are saved in resources, named by stereopairs names.

The Tasks number for computing points field displays calculated number of
tasks depending on selected way of workflow split and/or size of specified areas.

By default По умолчанию задается вложенная папка в папке \Data текущего проекта.

It is not possible to define number of tasks manually.
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6. In theWorking folder section click the button and select empty folder in active
profile resources to save output DEM.

Before operation is performed all data from selected folder is removed. It is strongly not
recommended to specify a project folder as a working folder, especially when there are no
saved project backups.

7. Click OK. Distributed processing tasks are created and the system shows amessage
about number of created tasks.

When using distributed points calculation, the result of each task is saved to separate file
with *.tsk extension in specifiedWorking folder of a project.

C.7.2.3. Buildings and vegetation filter

The system provides deletion, correction or recognizing points which have fallen on
buildings, trees, cars, in pits during automatic points calculation, and during filtering of
accident surges. For that filter of buildings and vegetation id used. After its work only
points that describe terrain relief are remain in the system.

In this document all points not lying on the relief surface (average smoothed terrain
surface), are called surges.

Filter of buildings and vegetation allows to apply step-by-step points filtering using
particular script, i.e. to apply points filtering in multiple passes with different parameter
sets.

It is possible to develop customized script of filter workflow or to use default script. Creating
script of buildings and vegetation filtering means specifying of passes set, order of their passing
and setup the parameters for each pass.

Step-by-step filtering allows to achieve optimal results of objects filtering on any type
of terrain to acquire points, that correctly describe terrain relief, and that could be used
to generate high quality DEM.

By default, the system uses standard script that includes three passes in the following
order:

1. Basic – main pass with parameters configured for filtering points not lying on the
relief surface (surges). On this step the system rejects majority of points on buildings,
and also correlators blunders (sharp spikes).

2. Additional – additional pass with parameters configured for searching surges,
missed during basic step.

3. Detailed (off by default) – the pass with parameters configured for filtering points
located on low objects, such as small buildings, cars, and so on.
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After filtering the system may perform the following actions with points found (surges):

• rejecting surges from initial points layer;

• correction of surges found on initial points layer, that means editing of surges Z-co-
ordinates;

• search for surges to analyse them with saving of found points to new vector layers
without changing initial points layer.

Fig. C.48. Parameters of buildings and vegetation filter

The Buildings and vegetation filter window allows to specify filtering parameters and
setup a number of filter passes. The Layer field displays a name of active vector layer.
The window contains a standard toolbar.

FunctionButtons
to load a script of filter work from *.x-filter resource located out of active profile re-
sources
to load a script of filter work from *.x-filter resource located in active profile resources
to save a current script of filter work to *.x-filter resource located out of active profile
resources
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FunctionButtons
to save a current script of filter work to *.x-filter resource located in active profile re-
sources
to cancel all changes made to a script
to go back to a standard script that includes two passes with default settings (regardless
of which script has been loaded)

To filter objects on surface perform the following actions:

1. Load points for filtration or make active a points layer.

To avoid loss of data, it is recommended to use a copy of initial layer during filtering.

To create a copy select Terrain › Points › Save as and specify new name of points file.

If a layer contains linear or area vector objects the filter may not work properly.

2. Select Terrain › Points › Filter › Buildings and vegetation filter or click the
Buildings and vegetation filter button on the Compute DEM tab of the main
toolbar. The Buildings and vegetation filter window opens.

Fig. C.49. Parameters of buildings and vegetation filter
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3. [optional] In order to use filtering for selected objects (points group), set the Filter
selected objects only checkbox on. Otherwise, filter is applied to all points of the
layer.

To filter a group of points, select it by mouse in 2D-window prior to start configuring the
buildings and vegetation filter.

When using filter for selected objects only, it is not recommended to set the Remove near
the border option in the Untestable points section.

4. [optional] To increase the filtering operation performance set the Copy points to
new layers before removing or correcting checkbox off. By default, the system
saves removed or corrected points in new vector layers used for analysis of filtering
results. These layers could be used to restore basic points layer (using operation
of layers merging), if the copy of initial points layer was not created prior to filtering
start.

If the Copy points to new layers before removing or correcting checkbox is off, it is
highly not recommended to apply filtering to initial points layer, since it is impossible to re-
store the initial layer after filtering.

5. In theUntestable points section specify one of the following actions with untestable
points found after filtering:

Some points can be untestable – the points, in which vicinity there is not enough ’neighbour’
points. For example, points located on the edge of the whole layer or in areas of low
density of points (fields, forests, water bodies).

• Remove all – allows to remove all found untested points;

• Remove near the border – allows to set a value of distance in meters from the
edge of the whole vector layer, at which all untestable points will be removed.
The Distance from the border field is used to do this;

• Mark only – allows to save untested points to separate vector layer for further
analysis.

6. [optional] Values of average distance between points in active layer calculates
automatically. Also the estimated distance between points is equal to average
distance by default. Set the Recalculate parameters for average distance
between points in the layer checkbox off to set the estimated distance between
points manually.

7. Specify a number of filter passes:

• by default it is used two passes with standard parameters –Basic andAdditional.
Set off checkboxes to change set of passes;
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• the button allows to add a new pass of filter;

• the button allows to remove selected pass of filter;

• the and buttons allow to move selected pass up/down.

The Filter passes section contains a table of passes and buttons used to change
set of passes and their order with the following columns:

• Pass – displays pass name and checkbox used to include a pass to script or to
exclude it from filter workflow script;

• Reliable surges – displays action to be applied to well-defined surges found,
that are completely comply with specified filtering criteria;

• Doubtful surges – displays action to be applied to ambiguous surges found, in
which vicinity there is no data enough for analysis.

It is necessary to select an action to be applied to reliable and doubtful surges during
configuring of pass parameters.

8. Select a pass name and click the Edit pass parameters> > button. The Pass
section is opened and allows to display and configure the following parameters of
filter pass:

Fig. C.50. Parameters of buildings and vegetation filter
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• [optional] to change name of pass, input a new one in the Name field;

• the Average distance between points in the layer (in meters) and Estimated
distance between points (in meters) after filtering are displayed in fields;

• specify Near and Far distance of mutual points influence in meters to define
the radius of the circle, in which the values of points are analysed for errors;

Near distance of points mutual influence – is the average radius of a circle where
the points are located that are attributed to the same flat surface towering above the
terrain (e.g. a flat roof).

Far distance of pointsmutual influence – is the average distance from points attributed
to the flat surface towering above the terrain where the points attributed to the terrain
are located for sure.

It is recommended to set the near distance (minimum circle radius) value as 3-5 values
of Average distance between points in the layer parameter.

Fig. C.51. Near distance of points mutual influence (a) and far distance of points mutual influence
(b)

• specify the following filtering parametersUp (above surface) and/orDown (below
surface):

○ Filter surges – allows to select points to be filtered: points on surface (high
objects) and/or points below surface (pits);
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For filter operating it is necessary to set at least one checkbox on.

○ Spikes only – is used to reject just sharp spikes above/below surface, that
are defined by values of the Threshold slope angle for spikes and Distance
of points parameters. The rest of parameters are not considered;

In an angle between three points exceeds a value of the Threshold slope angle for
spikes parameter, then the surge is called spike.

○ Threshold slope angle for spikes – allows to specify angle of slope in relation
to selected measuring plane (above and/or below surface) to define sharp
spikes;

○ Maximum area of flat surges – allows to define maximal area of plane surges
(above/below surface) – points groups, that form smooth surfaces and are
distant from some plane of neighbour points. Generally, the points are located
on buildings roofs, and are lying on the same plane;

The filter is not applied to plane surface, which area exceeds the specified value.

○ Intermediate smoothing radius – allows to specify a sphere radius
(above/below surface), that defines a level of intermediate smoothing of surface;

○ Allowed point deviation from from smoothed surface – allows to specify
criterion, according which the filter is applied to all points with elevations that
differ from smoothed surface more then on specified value;

○ Maximum area of inclined surges – allows to define maximal area of inclined
surges (above/below surface) – points groups, that form inclined surfaces on
the slopes.

The button allows to go back to a standard script that includes two passes with all
default settings (regardless of which script has been loaded).

9. In the Actions section specify actions for reliable and doubtful surges found after
any step of filtering:

• Delete – deleting of points found from base points layer;

• Correct – editing in base layer Z-coordinates of points found;

• Check – saving of found points in a new layer without change of base layer.
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Reliable corrected surges – found well-defined surges that satisfy completely to
all specified filtering criteria.

Doubtful surges – ambiguous surges in which vicinity there is no data enough to
analyse filtering operation possibility.

If the Delete or Correct option is selected, the system allows to edit base points
layer.

In order to save deleted or corrected points to new layers it is recommended to set the
Copy points to new layers before removing or correcting checkbox on.

If theCheck option is selected the initial points layer remains unchanged, and found
reliable or doubtful surges are copied to a new layer Surges.

10. [optional] To use all cores of workstation CPU for calculation operation, the Use all
available CPU cores checkbox is set on in the system by default. It is necessary
to set the checkbox off to use only one core.

11. Click OK. The system starts DEM filtering operation. When the filtering operation
is completed the system displays information message about number of used basic
points and filtered points.

There are the following recommendations concerning use of buildings and vegetation
filter:

• it is recommended to use step-by-step filtering (in multiple passes with different
parameter sets);

• the passes should be formed in ascending order of the following parameters: distances
of mutual influence, radius of intermediate smoothing, and decreasing of allowed
deviation of point from smoothed surface;

• value of intermediate smoothing radius directly describes terrain relief features, that
it why it is necessary to specify the radius value not exceeding 1500 meters;

• it is recommended to perform preliminary analysis of maximal area of flat surges on
given territory (to measure it in a stereopair window) and then to compare it with area,
calculated automatically for passes. If the measured area is bigger than calculated
one, it is necessary to increase it;

• it is highly not recommended to specify a distance of mutual influence of points ex-
ceeding a step between points in more than 20 times, since it leads to considerable
slowdown of filtering operation.
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C.7.3. Build TIN

Refer to the “Triangulation irregular network (TIN)” chapter of the “DTM Generation” User
Manual for the detailed information about TIN generation.

Triangulation Irregular Network (TIN) – one of the models of spatially coordinated data,
used during designing of digital terrain model as elevation points in nodes of irregular
network of triangles, that corresponds to Delaunay triangulation;

Delaunay triangulation – is a triangle polygonal network, formed on a set of discretely placed
points connected to each other by disjoint straight line segments in such a way, that a circle
circumscribed around each triangle does not contain points of initial set inside.

To perform TIN creation the system provides the following workflow:

1. [optional] Pre-regions building (see the “Creation pre-regions for a block” chapter
of the “DTM Generation” User Manual);

2. Defining of set of base vector layers (see the “Loading base layers for TIN creation
chapter of the “DTM Generation” User Manual);

3. TIN borders creation (see the “TIN borders creation” chapter of the “DTMGeneration”
User Manual);

4. Building TIN.

C.7.3.1. Building TIN

Perform the following actions to build TIN:

1. Choose the Terrain › TIN › Build (Ctrl+N, T) or click the Build TIN button on
the Compute DEM tab of the main toolbar. The Build TIN window opens.
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Fig. C.52. The Create TIN window

2. [optional] By default in the Source data section set on checkboxes for all opened
layers to use them in TIN creation. Set the checkboxes off, if some layers opened
are not used for TIN creation.

To select all available layers click the button, to unselect all layers – click the button.
To invert selecting layers it is used the button.

3. [optional] In the Quasicontours section the Display checkbox on and in the
Starting level filed specify minimal Z level (Zmin), from which to start quasi-contours
creation.

4. [optional] Specify the Interval of quasi-contours creation in meters.
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5. [optional] In order to create quasi-contours as smoothed curves, set the Smooth
contours checkbox on and specify the smoothing parameters.

• Input the Curvature radius for smoothing curve.

Set the auto checkbox to calculate the Curvature radius for smoothing curve automat-
ically.

• Specify in the input field the Precision parameter – maximal distance from
polyline segment to a curve in the area between the two closest vertices.

6. In the Border section set on the following:

• Convex border – a border is created with connecting of outer boundary points
of selected layer in such a way that TIN has the most smooth border;

It is recommended to create convex border, when some part of vector objects does not
cover all area of TIN creation (for example, when there are lakes and rivers on large
scale images).

• Nonconvex border – only closest border points of a layer are connected during
border creation.

The Smoothing slider position allows to specify distance between border points, and
if the distance between points is less than the specified, the border will be passed through
them. In the leftmost position of the slider point are connected sequentially, and in the
rightmost one the border looks like convex.

It is recommended to place the Smoothing slider in the middle and smoothly move it
to the left to get the best results.

• Use polygons from layer – to create a TIN with convex border in limits of area
of polygon(s) selected in the layers list. Select from the list a layer containing
polygons, that will be used as a border. In order to define a border of TIN creation
area, just from selected polygons, set the Selected only checkbox on.

7. Click OK. The TIN is created in the new TIN layer.

C.7.4. Build DEM

Refer to the “Digital Elevation Model” chapter of the “DTM Generation” User Manual for the
detailed information about DEM generation.

DEM (Digital Elevation Model) – is digital cartographic representation of the earth’s
surface in the form of a regular grid of height values.

A source data for DEM creation is the following data, taken individually or in combination:
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• TIN (Triangulated Irregular Network);

• regular or irregular points (point objects);

• vector objects (see the Vector objects creation chapter in the “Vectorization” User
Manual).

C.7.4.1. DEM creation by TIN

The system provides possibility to create DEM using irregular spatial triangles network
(TIN). Perform the following actions to do this:

1. Create or load source TIN.

2. Choose Terrain › DEM › Build DEM › From TIN (Ctrl+N, D) or click the Build
from TIN button on the Compute DEM tab of the main toolbar. The DEM by TIN
creation parameters window opens.

Fig. C.53. DEM by TIN creation parameters

3. Specify DEM borders in the North, West, East, South fields. In the Height and
Width fields the system displays calculated size of DEM border in meters.
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Default values are coordinates of rectangle corners, which generate TIN creation area.

4. In the Cell size specify the DEM cell size in meters to define cell size of output
DEM. The Cells number, calculated considering specified cell size, displays in the
Height andWidth fields. Also theApproximately DEM size in megabytes displays
in the appropriate field.

DEM cell size should be comparable to average distance between points of base TIN
layer. If less cell size is used, the time of DEM creation and size of output file increase, but
accuracy is not.

Click the From project button to setup DEM cell size that equals to average GSD value
in the project.

5. [optional] It is possible to use parameters of existed DEM to calculate parameters
of output DEM. To do that, click theCalculate parameters by existing DEM button
and choose DEM file in active profile resources.

6. Click OK. Specify DEM file name, define a folder in active profile resources and
click Save. The system starts DEM creation operation. After that the system creates
new layer in the Manager and shows a message about operation successful or
unsuccessful completion.

Whenmarker is moving over DEM, the status panel in 2D-window displays XYZ-coordin-
ates of DEM points.

The system allows to recreate DEM after changing of TIN base layer. To do this use
the Terrain › DEM › Rebuild by TIN menu item.

C.7.4.2. Dense DEM generation using SGM method

The system provides possibility of generation of dense digital elevation model (DTM),
which cell size coordinates to one pixel of image, using SGM (Semi-Global Matching)
method.

DEM creation using dense model is executed for adjusted images block only (see “Block adjust-
ment” User Guide). Otherwise the DEM generation is not performed or is performed incorrectly.

For dense DEM generation using SGM method the following output data is provided:

• [optional] DEM generation for a predetermined area;

○ [optional] True Ortho creation for an area limited by DEM boundaries.

• [optional] Point cloud (LAS) generation for an area limited by DEM boundaries.

For dense DEM generation using SGMmethod the system allows the following workflow:

130

Processing of UAS data (Windows x64)PHOTOMOD 8.1

solver.pdf
solver.pdf


1. DEM generation for a predetermined area;

2. Main processing: applying buildings and vegetation filters to created DEM and/or
performing empty cells restoring;

3. [optional] Additional processing — median and/or smoothing filtering.

If intermediate data is not deleted after operation completing, the system allows to run in-
dividual stages of the processing (filtering and smoothing) without re-calculation of the
source DEM.

To generate dense digital elevation model using SGM method perform the following
actions:

1. Specify a grid to define DEM creation area.

Since the coordinates calculation is performed in each pixel of the selected area, the grid
nodes are not considered. The grid is used just as a border of DEM creation area. A shape
of grid borders could be rectangular or as arbitrary polygon (or several polygons).

2. Select Terrain › DEM › Build DEM › Dense DSM (SGM method)... or click the
Dense model button on the Compute DEM tab of the main toolbar. The SGM
parameters window opens.

If a grid not was not created in advance, the Grid properties window opens, that allows
to create a grid for the entire images block.
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Fig. C.54. SGM parameters

The toolbar in the upper part of the window is intended to save/load parameters
settings of DEM creation and contains the following buttons:

• – allows to load parameter’s settings saved previously to active profile re-
sources;

• – allows to save all parameter’s settings to *.x-ini file located in active profile
resources;

• – allows to load parameter’s settings from *.x-ini file located in a folder of
Windows file system;

• – allows to save parameter’s settings to *.x-ini file located in a folder of
Windows file system;

• – allows to restore the last-session’s settings;

• – allows to restore default parameter’s settings.
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3. Define the Search area in the appropriate section:

• All images – allows to select all images of a block;

• Selected images – allows to select block images highlighted in 2D-window;

• Active stereopair – allows to select images of a stereopair opened in active 2D-
window.

All selected stereopairs should be located on adjusted part of a block (see “Block adjust-
ment” User Guide). Otherwise, the calculation is not performed or is performed incorrectly.
In the first case the system displays error message, in the second one – it is not possible
to match calculated points to project coordinate system.

4. Specify the settings that determine which stereopair selection method will be
carried out:

• By number of tie points – by default, during processing, one stereopair is selec-
ted for each of the images, based on the maximum number of common tie points.
The stereopair search is carried out over the entire block of images (both in-strip
and among images located on neighboring strips);

○ [optional] To usemore stereopairs, set the appropriate checkbox. The search
for additional stereopairs is also carried out among all the images. It should be
noted, that the number of potential stereopairs for each image (in particular,
taking into account inter-strip pairs) can be quite large. The system allows the
user to limit the max. number of stereopairs per image to no more than the
specified one, in the appropriate field.

Using additional stereopairs allows for compensating for insufficient overlaps between
images, which, under certain circumstances, can lead to errors in the construction of
output products, especially at block boundaries.

Inter-strip stereopair use may be necessary when processing Vision Map projects
(depending on source data features).

• By block scheme – one stereopair is selected for each of the images according
to the arrangement of images in the Block editor window (see “Images block
forming” of the “Creating project” User Manual). The creation of in-strip stereopairs
only is supposed (if the user has decided not to use more stereopairs).

Such an approach implies the correct arrangement of images in the block scheme and
a sufficiently high image overlap, which is not always feasible when processing UAS
data (in this case, the formation of stereopairs by block scheme is not recommended).
The formation of stereopairs by block scheme is justified in the lack (or insufficient
number) of tie point measurements
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Note, that in the latter case DEM creation using dense model can be performed correctly
for adjusted projects only. In turn, the steps of measuring tie and ground control point
coordinates can be excluded from project processing only if quite accurate exterior ori-
entation parameters of block’s images are available what makes it possible to use these
data for the project adjustment (see “Import of exterior orientation parameters” of the
“Aerial triangulation” User Manual).

○ [optional] To use more stereopairs, set the appropriate checkbox. It should
be noted, that the number of potential stereopairs for each image (in particular,
taking into account inter-strip pairs) can be quite large. The system allows the
user to limit the max. number of stereopairs per image to no more than the
specified one, in the appropriate field.

The search for extra stereopairs is carried out over the entire block of images (including
among images located on neighboring strips).

5. [optional] set the Limit intersection angle checkbox on to filter blunders by Z on
images with intersection angle of small or null value, and define a value of minimal
and maximal angles;

The system allows to estimate the intersection angles in the stereopairs of the project (see
the “The list of stereopairs for a selected image” chapter in “Creating project” User Manual
and the “Creation of “stereo quality” map” chapter in “Vectorization” User Manual).

6. In the Initial approximation section select a method of heights range calculation
for DEM generation:

• Stereopair heights range – heights range is calculated for each stereopair indi-
vidually using heights of project tie points measured earlier;

• Project elevation range – heights range is taken from theRelief elevation value
in project properties or is calculated using heights of project points measured
earlier;

• Constant elevation – input a height value in meters to be used as initial approx-
imation;

The Range extension field allows to increase height range by a predetermined
value to create a DEM. If the Constant elevation mode is on the option specifies
working range of heights (search area).

7. In order not to use boundary regions of imagery while DEM (LAS, true ortho) cre-
ation, set the Offset from image boundaries, % by clicking the button in the
SGM parameters section. The Image margin window opens. Set image margins
in percent which are not to be involved in processing;

It may be necessary so that only useful part of an image was processed (e.g. while pro-
cessing projects with analog imagery as source data).
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Fig. C.55. The Image margin window

Fig. C.56. Image margin

8. For more detailed settings of SGM cost calculation click Additional.... The SGM
parameters window opens.
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Fig. C.57. SGM parameters

Set the following parameters:

• Limit area of calculation (pixels) – specifies a size of parts that epipolar images
will be splitted to. The parameter’s value affects processing performance;

• Cost calculation method – CT (by default) or MI – this method is less sensitive
to non-linear values of images brightness, but more demanding in performance
(duration of DEM generation becomes 2-3 times longer);

• Paths number – number of calculation directions. It affects DEM accuracy and
generation time. Recommended values: 8, 16, 32;

• Penalty 1 – penalty for parallax change by 1 pixel. It is recommended to increase
this value when using extensively noisy images. The value may be reduced to
improve the accuracy of the DEM when using qualitative data;

The system allows to perform the automatic calculation on penalties. To set the
penalty 1 and the penalty 2 manually clear this checkbox.
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• Penalty 2 – penalty for parallax change by more than 1 pixel. It is recommended
to increase this value when using extensively noisy images. The value may be
reduced to improve the accuracy of the DEM when using qualitative data;

• Histogram smoothing radius – parameters used just for calculation by MI
method (see above). Defines smoothing level of epipolar images histogram;

• Pixel cost calculation radius – half-size of rectangular correlation mask in pixels
by X and Y axes;

• Disparity map interpolation – interpolation distance when auto-filling missed
results (null cells) by adjacent pixels;

• Minimum area of overlapping – minimal overlap area of epipolar image parts
in pixels. Recommended value: not less than 20;

• Maximum vertical parallax, in pixels;

• Filter DEM errors – allows us to delete isolated DEM areas (having sizes lesser
than set ones) during individual processing of each stereopair;

Isolated DEM areas – the cells with values beyond the boundaries of the main DEM or
among null cells.

• Use tie points – allows to improve DEM quality through the creation of temporary
triangulation points before DEM construction to refine the elevation ranges of
each stereopair involved in the construction.

It is recommended to use tie points in case when the stages of tie and ground control
points’ coordinate measuring were excluded from the project preprocessing, and the
preliminary adjustment necessary for dense DEM generation using the SGM method
was carried out according to imported exterior orientation parameters.

The creation of temporary triangulation point before DEM creation also can improve the
quality of output data in case of using data of initial imaging with large convergence
angles in stereopairs. Note, that preliminary creation of temporary triangulation points
is quite time-consuming.

9. To increase the system performance through graphic processing unit resources,
set the Use GPU checkbox and select the desired device from the drop-down list;

The intensity of GPU usage can be monitored using various free software. Windows 10
users can monitor GPU activity through theWindows Task Manager (Performance Tab).

It is recommended to use modern graphics adapters with at least 4-6 GB of memory, espe-
cially in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for
computations is not directly dependent on its memory amount but is influenced by the al-
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gorithms used and features of the system architecture.If there is a choice, first of all,NVidia
video adapters are preferable.

During distributed processing, video adapters are to be selected in theMonitor for Distrib-
uted Processing window, individually for each computer used as a distributed processing
client (see “Computers” in the “General information” User Manual. However, video adapters’
resources will be used for distributed computations only if the Use GPU checkbox is set
in the current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through theMonitor
for Distributed Processing, regardless of which device was selected in the drop-down
list in the current window (this choice is taken into account only in the case of standard
data processing mode).

10. [optional] To remove processing data after the calculation is completed set the
Delete intermediate data checkbox on. Click the (estimate the size) button to get
information about disk space occupied by intermediate data.

It is not recommended to remove intermediate data up to final creation of DEM. After re-
moving of intermediate data it is impossible to start separate steps (filtering or smoothing)
without DEM re-calculation.

11. In the output data section click the button that corresponds to the Working
folder field and choose an empty target folder in active profile resources to save
the output DEM.

If the selected folder already contains some data, before the execution of an operation the
system will offer to decide between emptying the folder or using the existing data for DEM
creation.

Fig. C.58. Question

12. Specify DEM cell size in meters to change size of output DEM cell.

The value of the DEM cell size parameter should not be less than average pixel size
(GSD). When using cell size with smaller size the time of DEM creation and a size of output
file are increasing, however, the processing accuracy is not improved at that.

Click the From project button to setup DEM cell size that equals to average GSD value
in the project.
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The final DEM cell size may change depending on detailed output DEM parameters
settings (see below).

13. [optional] to create DEM, set the appropriate checkbox it the DEM section, and
specify the following settings:

• [optional] To set the additional output DEM parameters click the Parameters
button in the appropriate section. The Output DEM parameters window opens:

Fig. C.59. Output DEM parameters

○ [optional] In the Auxiliary processing section specify the following filtering
parameters:

■ set the Median filter checkbox to use median filtering during DEM creation
and specify parameters of filter usage;

■ set the Smooth filter checkbox to use smooth filtering during DEM creation
and specify parameters of filter usage.

○ Specify DEM boundaries in the North,West, East, South. In the Height and
Width fields the system displays calculated size of DEM border in meters.
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The Height andWidth fields in the lower part of the window display the number
of cells of the DEM (if it would be created with current DEM cell size and
boundaries settings). There is also displayed the Estimated DEM size in
megabytes.

In order to Calculate parameters by existing DEM, click the appropriate button
and select existing DEM file in active profile resources. Click OK to apply these
parameter and close the Output DEM parameters window.

• Specify the Minimum number of counts in overlapped area parameter value
to setup reliability of DEM.

This parameter determines the minimum number of overlapped stereopairs required for
calculating the resulting DEM cell value.

The cell of the final DEM will be recorded if the number of overlapped stereopairs used
for its calculation is equal to the preset value (or exceeds it).

Correct choice of this parameter value depends on minimum stereopair overlap in a
block and on using interstrip stereopairs during DEM calculation (see above).

Recommended default value is 2. In case of a small overlap of stereopairs, it is recom-
mended to lower the value of the Minimum number of counts in overlapped area to
1.

To estimate stereopair overlap area in the project, choose Block › Create overlap
map... (see “Creating overlap map” of the “Creating project” User Manual).

Function Block › Create overlap map... allows only to estimate stereopair overlap in
the project, since map creation is carried out for images but not for stereopairs.

• Set the Coefficient from RMS to Max error, the parameter influencing the cell
value filtering whenmerging the final DEM from fragments created using separate
stereopairs.

The Coefficient from RMS to Max error participates in the calculation of merged DEM
fragment cell value tolerance. Decreasing this parameter’s value allows to build a DEM
with higher accuracy but it may cause the increased number of null cells. Increasing this
parameter’s value leads to the smoothing of DEM tile cell values during their merging.

Computation of a resulting DEM in overlap areas of several fragments calculated by
separate stereopairs is as follows:

○ Calculating the RMS of deviation from the mean elevation at the given cell;

○ Calculating a threshold value for the above RMS that is a product of Coefficient from
RMS to Max error and DEM cell size parameter values.

○ If RMS falls within the above threshold, the mean value of the cell elevation calculated
under these conditions is used as the resulting; otherwise, step-by-step filtering of
fragments involved in given cell processing takes place until an acceptable result is
achieved.
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• Set the output DEM filename.

14. [optional] To create the True Ortho, limited by DEM boundaries, set the appropriate
checkbox and specify the output true ortho filename. The True Ortho will be cre-
ated in the work folder, in the PHOTOMOD MegaTIFF (*.prf) format;

To create the true ortho set the create DEM checkbox beforehand (see above).

Creating the true ortho will notably (approximately 2-fold) increase the time required for
DEM creation.

PHOTOMOD GeoMosaic program allows to save later the obtained true ortho in any of
available formats (see the “Orthophotomaps creation” User Manual).

For more detailed setting of true ortho creation options, click the Parameters…
button. The True ortho parameters window opens:

Fig. C.60. The Fill NULL cells window
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• In DEM section, set Minimum building height in meters to exclude buildings
from interpolation of DEM null cells (see the figure below);

• In DEM section, set Cache size when filling option in megabytes – maximum
cache size allocated for a single task when creating true ortho;

• To Use RGBI channels for true ortho creation, set the appropriate checkbox;

A True Ortho creation using four channels is possible only when the images used as
source data have the 4th channel, e.g. infrared.

• In the True Ortho section, set the Global brightness adjustment checkbox to
apply global brightness adjustment over image overlapping areas when creating
an orthophotomap. For more detailed setting of brightness adjustment options,
click the Parameters… button. The Parameters window opens:

Fig. C.61. Brightness adjustment parameters

The opening window allows us to change the following settings of global brightness
adjustment:

○ Use statistic of overlapped areas with weight – allows to use the weight of
the images’ overlapping areas only;

○ Use statistic of entire images with weight – allows to use the weight of all
the pictures in the block;

If the images’ brightness in a block significantly differ, it is recommended to set a
small value.

○ Fix average brightness – allows to save average brightness of images in
block after global brightness adjustment;
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○ Fix etalon images with weight – allows to save (with preassigned weight)
brightness of reference (etalon) images;

See the detailed description of brightness adjustment processes when creating an or-
thophotomap in the “Orthophotomaps creation” User Manual.

• [optional] to apply the sharpening filter set the appropriate checkbox and click
the button to open the Filter parameters window:

The sharpen filter allows to highlight and intensify differences between image’s individual
details (image sharpness). See the “Radiometric correction” chapter of the “General in-
formation” User Manual.

Fig. C.62. Filter parameters

Set the following parameters:

○ In the Aperture size list define the matrix size from 3x3 pixels to 21x21 pixels.

○ Move slider to define Filtering level in percent.

○ Set the Threshold. Click OK to close the window.

Each single image element is filtered only if the brightness difference between adjacent
elements exceed the given filtering Threshold. This helps to avoid errors looking as
spots in the areas of an image with originally uniform hues.

• [optional] clear the Fill NULL cells checkbox in the True Ortho section in order
not to fill null cells when creating a DEM (what can lead to creation of unfilled
areas when creating an orthophotomap) or specify the following parameters:
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The name of unfiltered output DEM with unfilled null cells has to look like the following:
<DEM name>_tmp.x-dem (automatically set).

The name of output True Ortho with non-interpolated null areas has to look like the fol-
lowing: <True Ortho name>_tmp.prf (automatically set).

○ Overwrite valuable cells in NULL areas – allows to exclude isolated DEM
areas from interpolation of DEM null cells (i.e. interpolate these areas as a
NULL cells);

Isolated DEM areas – the cells with values beyond the boundaries of the main DEM
or among null cells.

○ Interpolate not filled NULL cells – allows to interpolate unfilled DEM/ortho-
photomap areas;

○ Fill single NULL cells – allows to interpolate areas without data having one
pixel size in a DEM or orthophotomap;

○ Visibility distance – the distance within which the visibility of points located
in unfilled areas of an orthophotomap is checked in the project’s images;

○ Visibility step – an increment with which the visibility of points located in unfilled
areas of an orthophotomap is checked in the project’s images;

○ Maximal barrier height – an approximate maximal height of the objects
towering above the Earth surface and hiding some terrain areas (see the illus-
tration below);

○ Maximum images per pixel – maximum number of images of the project
where the visibility of points located in unfilled areas of an orthophotomap is
checked;

The system calculates default Visibility distance, Visibility step and Maximum
images per pixel based on the DEM cell size specified by the user (see above).

If, after closing the Fill NULL cells window, the user changes the DEM cell size in
the SGM parameters window, Visibility distance, Visibility step and Maximum
images per pixel manually set by the user will be automatically recalculated.

When setting parameters for null cell filling, the survey geometry (off-nadir angles) is
to be taken into account, as well as the geometry of the terrain itself (heights of objects
located on the terrain). If the results of cell filling are found to be unsatisfactory, in-
crease visibility distance and visibility step (given that this will increase the time
spent on the operation).

○ Filter outliers – allows to perform orthophotomap median filtering with preset
Threshold. The statistics is collected in the neighborhood whose area is de-
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termined by the Aperture size. This filter is used for removing single pixels
with unnatural brightness;

○ Set the Acceptable pixel color RMS, the parameter influencing the filtering
of pixels of various images when creating a true ortho.

Decreased values of this parameter lead to exacting tolerance for pixel colors of
various images, and, as a consequence, may cause the decrease of the number of
images used for the calculation of each true ortho pixel.

• Define the output True Ortho pixel color selection method:

The color of each True Ortho pixel is calculated over several images involved in the
processing of a particular pixel. By setting an acceptable pixel color RMS, the user
can pre-exclude from the processing those images, the color of a particular pixel of
which differs significantly from the corresponding pixels of the other images.

○ Use the color closest to nadir – only one image with the smallest deviation
from the nadir angle, relative to a given pixel is involved in determining the
resulting color of a pixel;

When using this technique, well-marked differences between the colors of adjacent
pixels may be observed in the output True Ortho, even if global brightness adjust-
ment is used (see above).

○ Use the pixel color of one of the images that is closest to average color cal-
culated for this pixel (according to all images involved in processing);

○ Use weighted color selection;

○ Set average color (average the data of all images involved in the pixel calcu-
lation)

• [optional] set the Overwrite existing DTM/TrueOrtho checkbox in order not to
use intermediate data from the working folder (if DEM and orthophotomap has
already been created) but overwrite them.
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Fig. C.63. An example of unfilled area on true ortho, where a is the building height (seeMaximal
barrier height parameter), b is the “isolated DEM area” among DEM NULL cells (seeOverwrite
valuable cells in NULL areas checkbox), с is the Visibility step, R is the Visibility distance,
S is the unfilled DEM/orthophotomap area (due to the fact that the image is the central projection
of terrain and objects towering above the Earth surface hide some terrain areas, thus they are
not seen on the image). Also, the quality of an orthophotomap is affected by the zones hidden

by the object’s shadow, and brightness adjustment is required.

15. [optional] To create an output point cloud (LAS) set the appropriate checkbox
(see the “LIDAR Data processing” User Manual). For more detailed setting of point
cloud creation parameters, click Parameters... button. The LAS creation paramet-
ers window opens:

If the Create point cloud (LAS) checkbox is set, it is recommended to use the distributed
processing mode for dense DTM creation using the SGM method.

Points cloud will be saved in the separate LAS directory in the folder chosen for output
DEM saving in the active profile’s resources.
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Fig. C.64. The Create LAS parameters window

• Set the Maximum intersection angle and mininum intersection angle in de-
grees to filter blunders by Z on images with intersection angle of small or null
value;

Before configuring these parameters, it is recommended to assess the overlapping of
the project images as well as the intersection angles of the stereopairs used in data
processing.

To estimate the project images overlaps, choose Block › Create overlap map... (see
“Creating overlap map” of the “Creating project” User Manual).

The system provides the different methods to estimate the intersection angles in the
stereopairs of the project (see the “The list of stereopairs for a selected image” chapter
in “Creating project” User Manual and the “Creation of “stereo quality” map” chapter in
“Vectorization” User Manual).

To set theminimum intersection angle among all stereopairs used in data processing
as a limiting value, set the autocalculate minimum intersection angle checkbox.
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In most cases, especially when processing data with a large number of overlaps and
multiple small intersection angles, leave this checkbox set

Increasing themininum intersection angle manually, user can achieve more LAS ac-
curacy due to tighter point filtering.

• To classify vegetation by IR channel (if available) set am appropriate checkbox
(see the “Vegetation classification” chapter of the “LIDAR Data processing” User
Manual);

• Set Point cloud density in meters;

By default, Point cloud resolution is twice as large as the DEM cell size (see above).

It is not recommended to set Point cloud resolution lesser than the DEM cell size.

• Specify the Number of returns – the minimum number of stereopairs required
for point calculation;

○ Specify the Max neighborhood images number – the maximum number of
images used for stereopairs creation.

• To perform the preliminary gross errors filtering (for the LAS fragments calcu-
lated for the single images) set an appropriate checkbox and click the appropriate
button to set filtering parameters (see the “LAS statistical outlier removal” chapter
of the “LIDAR Data processing” User manual);

• To perform the small group points filtering set an appropriate checkbox and
click the appropriate button to set filtering parameters:

Fig. C.65. The “LAS small group filter parameters”

○ Min number of voxels in one cluster – if the number is less, the cluster will
be deleted;

○ Min number of points in a voxel;
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○ Size of Voxel side in one cluster – the side size of the single voxel in project
units.

The small group points filtering allows to delete point groups out of the main cloud
which are located at some distance and most likely are noisy.

A volumetric pixel (voxel) is the three-dimensional equivalent of a pixel and the tiniest
distinguishable element of a 3D object. Volume pixels are used like building blocks
to form a larger 3D object.

In this case, a voxel is a small fragment of the point cloud, within which the calculations
are performed. Not to be confused with the LAS point cloud tile.

The cluster is the group of voxels.

• To use the smooth filter for the output points cloud set an appropriate checkbox
and click the appropriate button to set filtering parameters (see the “LAS fusion”
chapter of the “LIDAR Data processing” User manual);

• To use themedian filter for the output points cloud set an appropriate checkbox
and click the appropriate button to set filtering parameters (see the “LAS fusion”
chapter of the “LIDAR Data processing” User manual);

• To perform the final block filtering (statistical outlier removal for the output
points cloud) set an appropriate checkbox and click the appropriate button to set
filtering parameters (see the “LAS statistical outlier removal” chapter of the
“LIDAR Data processing” User manual);

• Specify the size of the output block side to set the output LAS tile size. The
default size of the output block side is 1000 points cloud GSD (see the Point
cloud density parameter above).

16. Click OK to start dense DEM generation operation in normal mode. Output DEM
is opened in a new layer after the creation is finished. Output true ortho is also
opened in a new layer if the corresponding checkbox was turned on.

In order to generate DEM using distributed processing, perform the following actions:

While building DSM by SGM method in distributed processing mode, stereopairs are pro-
cessed separately in different tasks (see the Searching area section). The last task is re-
sponsible for merging data acquired.

1. Start the server/client of distributed processing mode (see the “Distributed
processing” chapter in the “General information” User Guide).

2. Open the Monitor for distributed processing and specify Max MT tasks –
the maximum quantity of simultaneously running tasks onClient inMultiThread-
ing mode;
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MultiThreading – in computer architecture, multithreading is the ability of a central
processing unit (CPU) (or a single core in a multi-core processor) to provide multiple
threads of execution concurrently, supported by the operating system.

This approach differs frommultiprocessing. In a multithreaded application, the threads
share the resources of a single or multiple cores, which include the computing units,
the CPU caches, and the translation lookaside buffer (TLB).

Where multiprocessing systems include multiple complete processing units in one or
more cores, multithreading aims to increase utilization of a single core by using thread-
level parallelism, as well as instruction-level parallelism. As the two techniques are
complementary, they are sometimes combined in systems with multiple multithreading
CPUs and with CPUs with multiple multithreading cores.

When setting this option, it is needed to take into account the Client’s specifications
i.e.RAM and the number of processor cores. The recommendedMaxMT tasks value
for a workstation having a multicore processor and 8 GBRAM is 1. The recommended
Max MT tasks value for a workstation with 16 GB RAM is 2, etc.

3. Click the Distributed processing... button.

Depending on the size of creation area the operation can take a long time.

To provide a system performance while building dense DSM by SGM method it is recom-
mended to use Distributed processing mode.

C.7.4.3. Slope based filter

The system allows to filter objects based on slope angle.

While using a filter, DEM cells covering buildings, vegetation, man-made objects and
accident spikes are searched for and removed. As a result of filtering DEM contains
heights of “true relief” only.

1. Make active a DEM layer;

2. Select Terrain › DEM › Filter › Slope based filter… or click Slope based filter
button on theCompute DEM tab of themain toolbar. TheSlope based filterwindow
opens;
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Fig. C.66. Parameters of slope based filter

3. In Input DEM section click button and select DEM to filter in resources of the
active profile;

4. InOutput DEM section click button and specify name and target folder to keep
output DEM in resources of the active profile;

5. In Size of object to be removed section specify the typical object size in XY-plane
and typical object size along Z axis in following fields in meters:

• Plane distance (max);

• Height (min).

• Slope angle (min) in degrees.

A slope angle is one of the parameters used to calculate a threshold for filtering. For
example, for a plumb-wall building, the slope angle is ~ 90 degree (note, that due to
the peculiarities of DEM construction, this angle will never be exactly 90 degrees).

The slope angle is selected individually in each case for the distinctive buildings and
objects that need to be removed. Large values of slope angles (about 80 degrees) may
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lead to the fact that those buildings of specific shapes (e.g. hangars) may not be removed
during filtering. Decreasing the slope angle (e.g. to 45 degrees) may lead to removing
some accidents of terrain (e.g. elevations having similar shapes and sizes) along with
abovementioned buildings.

6. To perform initial filtration of a thinned original DEM, set the Intermediate DEM
pyramid level determining the degree of thinning.

Increasing the degree of thinning makes it possible to significantly improve the system
processing performance, lowering the quality of filtration. Recommended values of Inter-
mediate DEM pyramid level are 1, 2, or 3.

To set zero value is strongly discouraged.

7. [optional] Set Use selected polygons checkbox to filter DEM in the borders of
selected polygons only. Select where filtration will be performed:

• Inside selected polygons;

• Outside selected polygons.

ToUse selected polygons, before opening Slope based filterwindow perform the follow-
ing:

• Create vector layer (see the “Vectorization” User Manual);

• Create one or several polygons which limit selected fragments of DEM or load vector
layer with polygons to use them as boundaries for filtering;

• Select no less than one polygon which is used as a boundary for filtering.

8. [optional] Set Open Dem after filtering checkbox to open output DEM in a new
layer immediately after filtration completion.

9. [optional] To remove processing data after the calculation is completed set the
Delete intermediate data checkbox on.

10. Click OK. A process of filtering DEM is started. Output DEM is opened in a new
layer if the corresponding checkbox was turned on.

To use distributed processing for DEM slope based filtering, do the following:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing button.
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C.7.4.4. Filling null cells using smooth interpolation

The system provides possibility to restore null cells of DEM using the smooth interpolation
method. When applying the method of smooth interpolation the system evaluates the
factor of input DEM thinning to obtain auxiliary DEM. An auxiliary DEM is used to calcu-
late elevation values of null cells, and DEM cells with filled elevations are not re-calcu-
lated. Borders and cell size of output DEM are fully correspond to the boundary and
the cell size of the input DEM.

This method is recommended for a sufficiently dense DEM.

To fill DEM null cells by smooth interpolation method perform the following methods:

1. Select Terrain › DEM › Fill null cells › Smooth interpolation... or clock Slope
based filter button on the Compute DEM tab of the main toolbar. The Parameters
of filling null cells in DEM window opens.

Fig. C.67. Parameters of filling null cells using smooth interpolation

The window displays the ground sample distance (GSD) of input DEM in meters.

2. In the Input DEM section click the button to select input DEM in active profile
resources.
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The DEM loaded to the project is selected by default.

3. [optional] To define name and target folder of output DEM in active profile resources,
click the button.

By default the system suggests the <input dem name>_filled.x-dem name for output DEM
and to place it to the folder, containing input DEM file.

4. Input the Auxiliary DEM subsampling. After that the GSD of auxiliary DEM is
calculated automatically.

The Auxiliary DEM subsampling must be an odd number.

5. [optional] In the DEM border section, set the Select from layer checkbox to set
border of the output DEM using a vector polygon.

It is required to create in advance a vector layer with one polygon which sets borders of
the output DEM.

From the opened list of downloaded vector layers, select one vector layer that
contains a polygon limiting a DEM;

6. [optional] In the DEM border section, set the Build checkbox to create borders of
the output DEM automatically;

7. [optional] To remove processing data after the calculation is completed set the
Delete intermediate data checkbox on;

8. Click OK. The system starts calculation of null cells elevation using smooth interpol-
ation method. After that the system creates new DEM layer in the Manager.

To use distributed computing for DEM rebuilding, do the following:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing button.

C.7.5. Build contours

Refer to the “Contour lines” chapter of the “DTM Generation” User Manual for the detailed in-
formation about contours generation.
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C.7.5.1. Generation contour lines by DEM

The system provides possibility to create contour lines by digital elevation model (DEM).

In order to build contours using DEM perform the following actions:

1. Load a DEM layer.

2. [optional] Create and select one or multiple vector polygons, if it is needed to build
a contours inside selected polygons;

3. Choose Terrain › Contours › Build contours › From DEM... or click Build
contours button on the Compute DEM tab of the main toolbar. The Contours
creation parameters window opens.

TheDEM parameters section displays information about elevation difference (Min.
elevation, Max. elevation) in DEM.

Fig. C.68. Parameters of contour lines generation by DEM
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4. [optional] In order to perform the of DEM smoothing operation, prior to contours
creation, set the Smooth checkbox on in theDEM section. Specify smoothing level
in the Smooth level field (maximal smoothing is applied at 1 value).

During smoothing the system uses information about adjacent nodes in each DEM node.
In order to specify number of adjacent nodes of DEM, select the Aperture size in the list.

5. [optional] To apply Gauss smoothing algorithm set the Smooth byGauss checkbox;

6. [optional] Set the Build inside selected polygons checkbox to create a contours
within the selected polygons;

7. [optional] Input minimal elevation level (Zmin), which will be zero-level for contours
creation, to the Starting level field.

In order to obtain information about about elevation difference (Zmin, Zmax), select Edit ›
Active layer › Layer information or click the DEM layer by mouse right button in the
Manager and select Information. The system displays the information window that contains
information about the layer.

8. In the Interval field specify contours interval in meters. Interval of Basic contours
equals to 1 contours Interval (displayed in the Basic contours field).

9. [optional] To create index contour lines the Index contour lines checkbox is on by
default. Set the checkbox off to cancel index contour lines creation.

The interval of index contour lines equals to five intervals of basic contours by default.
The system allows to set arbitrary interval of index contour lines manually.

10. [optional] To create intermediate contour lines the Intermediate contour lines
checkbox is on by default. Set the checkbox off to cancel intermediate contour lines
creation.

The interval of intermediate contour lines equals to half of basic contours interval by
default. The system allows to set arbitrary interval of intermediate contour linesmanually.

11. [optional] In order to create contours as smoothed curves, set the Smoothing
checkbox on and specify a level of smoothing using the slider.

12. [optional] In order to cancel creation of short contours, set the Skip contour lines
shorter than checkbox on and input minimal contour length in meters.

13. Click OK. After that the system starts to create contours in a new layer Contours.
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C.8. Оrthorectification

Orthoimage is a georeferenced image prepared from a perspective photograph or other
remotely-sensed data in which displacement of objects due to sensor orientation and
terrain relief have been removed.

The system provides possibility of creating orthoimages by source images block. This step allows
to prepare images for further processing and creating mosaic in theGeomosaic programprogram.

During orthorectification the system corrects relief displacement, axial angle, camera
distortion, etc. For images orthorectification it is necessary to specify output orthophoto
cell size, select output image coordinate system and scale, specify output file format
and georeference type.

Prior to create orthoimages it is necessary to adjust images block (see “Block adjustment” User
Manual).

The Orthorectification toolbar is used for creating orthoimages.

In order to display the toolbar, choose the Rasters › Orthorectification (Ctrl+Alt+M)
or click the button on the main toolbar.

The following elements are displayed in the Orthorectification toolbar title:

• A toolbar name: Orthorectification;

• [optional] The “*” symbol meaning that current orthorectification settings have been
changed, and hence the orthorectification project is to be saved or overwritten ( ,
);

If the project is not saved before orthorectification start, an appropriate info message is issued
before the operation that offers to save this project (see below).

• [optional] Current orthorectification project name.

The project name is in quotes, after the window name and the “*” symbol (which, in turn, is
displayed if the project has unsaved changes)

Table C.1. The Orthorectification toolbar

FunctionButtons
to create the new orthorectification project
to open an orthorectification project from active profile resources
to save an orthorectification project
to save an orthorectification project with a new name
to open the Images list window (see the ’Creating project’ User Manual)
to set the orthorectification parameters
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FunctionButtons
to set the percent of trim image edges during orthorectification manually
to specify the percent of trim image edges during orthorectification by setting the residual
overlap
to perform the accuracy control of orthorectification
to start of orthoimages building and creation of output file for selected sheet
to start orthoimages creation for specified active sheets considering user settings and
parameters in distributed processing mode
to start of orthoimages building in the MegaTIFF format using the distributed processing
mode
to create a separate layer with orthoimage for each of selected images
to measure a building height (see the “Vectorization” User Manual)
to show general information about project (number of images channels, byte per channel,
number of images and output size of mosaic)
to move to previous image in a block scheme. The first image of the first strip opens if
the block scheme 2D-window is active
to open selected in 2D-window of a block scheme image in a separate window
to move to next image in a block scheme. The last image of the last strip opens if the
block scheme 2D-window is active
to close all separate raster FastOrtho layers

Refer to the “Orthorectification” User Manual for the detailed information about orthorectification.

Appendix D. Input and output data
Input data

During the project creation, aerial triangulation and block adjustment the following source
data is used:

• [optional] The list of GCP coordinates is necessary for block adjustment. The system
provides opportunity to measure GCP coordinatesmanually and also to perform import
of GCP list from a text file.

• [optional] The list of projection centers coordinates to process central projection im-
ages. The program also provides the ability to import on-board data (coordinates)
about projection centers from CSV files.

Block adjustment could be process only by projection centers without using ground control
points. It is recommended to use GCP coordinates to increase adjustment accuracy.

• Raster images
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For working with images in program , it is recommended to use MS-TIFF internal
raster format, which is the TIFF format with overview pyramid (set of subsampled
images copies) for higher image display performance.

The Raster Converter module is used to preliminary raster image processing. It is
possible to convert image into internal format both manually, before creating project,
and on the stage of adding images into project with saving converted images into
active profile resources. See theRaster Converter module description in the “General
information” User Manual.

The following image formats are available to process central projection images:

○ JPEG (JPEG);

○ Tag Image File Format (TIFF) TIFF и GeoTiff format, included tags for saving of
georeference information;

○ Windows Bitmap File (BMP);

○ Advanced Systems Format (ASF).

• Information about coordinate system and map projection – during project creation it
is necessary to define coordinate system of GC points. By default there is an Interna-
tional coordinate system database and map projection (see the details in the “Geo-
Calculator” User Manual);

• also it is possible to use the following exterior data:

○ import of triangulation points from PAT-B and X-POINTS;

○ import of ground control points from text files *.txt and *.csv (see above The list
of GCP coordinates);

○ import of interior and exterior orientation data from metadata;

○ import of external orientation data from PAT-B and CSV-files (see above The list
of projection centers);

○ GPS data;

○ import additional data from different formats.

Output data

The program allows to process UAS data and acquire all types of value added photo-
grammetric products: DEM, 2D and 3D-vectors, orthomosaics.

There are the main output products:
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• Digital Terrain Model (DTM) – digital cartographic presentation of terrain surface both
as regular grid of elevations (DEM) and as triangulated irregular network (TIN). They
are used for solving applied research problems.

• 3D vector objects – used for creating a topographical base for cartographic production
or as source data for a mathematical representation of a scene in three-dimensional
digital terrain modeling;

• orthophoto production – single raster images in the form of a single frame or a set of
sheets in a selected map projection with marginalia. In the resulting image, geometric
and photometric distortions are corrected, creating seamless, color-balanced ortho-
photos with uniform brightness as an output;

• 3D models of terrain – can be used to solve applied research problems, as well as
for creation of multimedia presentations and commercials.

There is opportunity to export all photogrammetric products to various formats.

Appendix E. The PHOTOMOD8UAS.VAR configuration folder
At the stage of system first configuration is automatically created the PHOTO-
MODUAS8.VAR folder. This folder is used to store configuration, temporary and other
system files.

Only one PHOTOMODUAS8.VAR folder creates, even for several installed copies of
the system.

It is not recommended to place the configuration folder in the net, because it leads to slowing
of system’s work.

PHOTOMODUAS8.VAR folder contains the following files and folders:

• AutoSave folder – is used to store autosaved data:

• Config folder – is used to store files of general parameters of all profiles;

It is possible to return to default parameters in case of changing configuration file. To do this,
remove a configuration file in the PHOTOMODUAS8.VAR folder and restart the system.
Default configuration file are copied from the PHOTOMODUAS8.VAR\Config system files
folder.

Both global settings and settings for the local profile is loaded at startup of the system and
saved when you exit. Local project settings is loaded when loading a project and saved when
project closing. In case of working without projects, settings are stored in the PHOTO-
MODUAS8.Var\Profiles\[profile_name]\VoidProjOptions.x-ini file.

• Logs folder – is used to store log-files for all profiles;
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• Profiles folder – is used to store all parameters for each profile separately. The list
of local and network profiles is also stored in the folder. It is the same list as in the
Control Panelmodule (see the “Control Panel. Profiles management” chapter of the
“General information” User Manual). Configuration file with resource structure and
path to local/network folder is also stored in folder of each profile;

New subfolder creates for each profile.

• Tmp folder – is used to store temporary files;

• UserData folder – is used to store data out of resources system;

• policy.x-ini file – contains general information about configuration parameters (active
profile name, name and path to centralized management folder and so on).
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